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About This Guide

IMPORTANT! Before using this product, read and understand the information the
“Safety” appendix in this document.

Purpose

The AmpF(STR™ Identifiler™ Direct PCR Amplification Kit User Guide provides
information about our instruments, chemistries, and software associated with

the AmpF(STR™ Identifiler™ Direct PCR Amplification Kit.
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Product overview

Purpose

Substrate
examples

Product
description

Overview

Product OVErVIEW . . . ..o e 9
WOTKELOW . . o o 12
Instrument and software OVErview . .............ouueiineeineennneennn. 13
Materials and equipment .......... ... ... 14

The AmpF(STR™ Identifiler " Direct PCR Amplification Kit is a short tandem repeat
(STR) multiplex assay optimized to allow direct amplification of single-source:

Blood and buccal samples on treated paper substrates without the need for
sample purification.

Blood and buccal samples collected on untreated paper substrates and treated
with Applied Biosystems™" Prep-n-Go'" Buffer.

Buccal samples collected on swab substrates and treated with Applied
Biosystems' " Prep-n-Go'" Buffer

The Identifiler™ Direct Kit amplifies 15 autosomal STR loci (D85S1179, D21511,
D75820, CSF1PO, D351358, THO01, D135317, D165539, D251338, D195433, vWA, TPOX,
D18551, D55818, and FGA) and the sex-determining marker, Amelogenin, in a single
PCR reaction.

The

Treated paper: Copan NUCLEIC-CARD™ system or Whatman™ FTA™ cards
Untreated paper: Bode Buccal DNA Collector' or 903 paper
Swab: Copan 4N6FLOQSwabs ™

Identifiler Direct Kit contains all the necessary reagents for the amplification

of human genomic DNA.

The reagents are designed for use with the following Applied Biosystems"
instruments:

Applied Biosystems'" 3100/3100-Avant Genetic Analyzer
Applied Biosystems'" 3130/3130x! Genetic Analyzer
Applied Biosystems'" 3500/3500xL Genetic Analyzer
Applied Biosystems'" 3730 Genetic Analyzer

GeneAmp " PCR System 9700 with the Silver 96-Well Block

GeneAmp ' PCR System 9700 with the Gold-plated Silver 96-Well
Block

Veriti"" 96-Well Thermal Cycler
ProFlex™ PCR System

AmpFtSTR™ Identifiler ™ Direct PCR Amplification Kit User Guide 9



About the primers

Product overview

Loci amplified by
the kit

Chapter 1 Overview

The Identifiler™ Direct Kit employs the same primer sequences as used in the
AmpF(STR™ Identifiler'™ PCR Amplification Kit. Degenerate primers for the loci
D851179, vWA, and D16S539 are included in the AmpF(STR™ Identifiler™ Direct
Primer Set to address mutations in the primer binding sites. The addition of the
degenerate primers allows for the amplification of those alleles in samples containing
the mutations without altering the overall performance of the Identifiler'" Direct Kit.

Non-nucleotide linkers are used in primer synthesis for the following loci: CSF1PO,
D135317, D165539, D251338, and TPOX. For these primers, non-nucleotide linkers are
placed between the primers and the fluorescent dye during oligonucleotide synthesis
(Butler 2005, Grossman et al., 1994, and Baron et al., 1996). Non-nucleotide linkers
enable reproducible positioning of the alleles to facilitate inter-locus spacing. The
combination of a five-dye fluorescent system and the inclusion of non-nucleotide
linkers allows for simultaneous amplification and efficient separation of the 15 STR
loci and Amelogenin during automated DNA fragment analysis.

Table 1 shows the loci amplified, their chromosomal locations, and the corresponding
fluorescent marker dyes. The AmpF(STR™ Identifiler'" Direct Allelic Ladder is used
to genotype the analyzed samples. The alleles contained in the allelic ladder, and the
genotype of the AmpF/STR"" Identifiler' " Direct Control DNA 9947A, are also listed
in the table.

Table1 AmpF(STR™ Identifiler™ Direct PCR Amplification Kit loci and alleles

des"i;f‘:fion Ch[:(':‘;:’ii‘:‘me Alleles included in Allelic Ladder Dye label Dﬁ:'};;:; A
D8S1179 8 8.9 10, 11, 12, 13, 14, 15, 16, 17, 18, 19 6-FAM™ | 13,13
D21511 21q11.2-q21 24, 24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, 30.2, 31, 30, 30
31.2,32.32.2, 33, 33.2, 34, 34.2, 35, 35.2, 36, 37, 38
D75820 7q11.21-22 6.7,8,9,10, 11, 12, 13, 14, 15 10, 11
CSF1PO 5433.3-34 6.7.8,9,10, 11, 12, 13, 14, 15 10, 12
D351358 3p 12,13, 14, 15, 16, 17, 18, 19 vic™ 14, 15
THO1 11p15.5 45,6,7,8,9, 93 10,11, 133 8 93
D135317 13q22-31 8.9, 10, 11, 12, 13, 14, 15 1,11
D165539 16q24-gter 58,9, 10, 11, 12,13, 14, 15 1,12
D251338 2435-37.1 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28 19, 23
D195433 1912-13.1 9,10, 11,12, 12.2, 13, 13.2, 14, 14.2, 15, 15.2, 16, = NED™ 14,15
162, 17, 17.2
WA 12p12-pter 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24 17,18
TPOX 2p23-2per 6.7.8,9,10, 11, 12,13 8 8
D18S51 189213 7.9,10,102, 11,12, 13,132, 14, 142, 15, 16, 17, 15, 19
18,19, 20, 21, 22, 23, 24, 25, 26, 27
Amelogenin X: p22.1-22.3; Y: p11.2 | X, Y PET™ X
D5S818 5q21-31 7.8.9,10, 11,12, 13, 14, 15, 16 1,11
FGA 4q28 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, 27, 28, 23, 24
29,30, 30.2, 31.2, 32.2, 33.2, 42.2, 43.2, 4.2, 45.2,
46.2, 47.2, 482, 50.2, 51.2

10
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Product overview

Allelic ladder Figure 1 shows the allelic ladder for the Identifiler Direct Kit. See “Allelic ladder
requirements” on page 28 for information on ensuring accurate genotyping.

Figure 1 GeneMapper™ ID-X Software plot of the AmpF(STR™ Identifiler™ Direct Allelic Ladder
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Workflow

Workflow

Perform c 9 c 9
PCR T - Treated or untreated paper 'S =1 Swab
a £ substrates o £ substrates
om owm
(2] [12]
o v o v
g3 83 Lyse in
o E o E Prep-n-Go™ Buffer
a3 a 3
HarrisManual  cpa200™ or CPA300™
Punch instrument

Untreated paper only: Prep-n-Go™

Buffer ™ e TM
AmpF(STR™ Identifiler ™ Direct PCR

Amplification Kit

Prepare

reactions
Prepare
reactions

AmpF(STR™ Identifiler™ Direct PCR
Amplification Kit

GeneAmp™ PCR System 9700 Cycler ProFlex™ PCR System Veriti'™ 96-Well Thermal Cycler

Perf 7 i
o e gt B

Perform
PCR

phoresis
3100/3100-Avant 3130/3130x! 3500/3500xL 3730 Genetic
Genetic Analyzer Genetic Analyzer Genetic Analyzer Analyzer
Analyze
data .,
&
GeneMapper™ ID-X Software GeneMapper™ D Software

12 AmpFISTR™ Identifiler™ Direct PCR Amplification Kit User Guide
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Instrument and software overview

Instrument and software overview

Data collection and

analysis software

Instrument and
software
compatibility

About
multicomponent
analysis

How
multicomponent
analysis works

This section provides information about the data collection and analysis software
versions required to run the Identifiler'" Direct Kit on specific instruments.

The data collection software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the data collection
software collects the data and stores it. The data collection software stores information
about each sample in a sample file (.fsa files for 31xx and 3730 instruments and .hid
files for 3500 instruments), which is then analyzed by the analysis software.

Instrument Data collection software Analysis software

3100/3100-Avant | 1.1 (3100) o GeneMapper™ ID
1.0 (3100-Avant] Software v3.2.1
o GeneMapper ™ ID-X
2.0 Software v1.0.1 or later
3130/3130x(* 3.0
37307 3.1

3500/3500xL 3500 Series Data Collection

Software v1.0

GeneMapper™ ID-X Software
v1.2 or later

+ We conducted validation studies for the Identifiler™ Direct Kit using these configurations.

Life Technologies fluorescent multi-color dye technology allows the analysis of
multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
overlapping loci are distinguished by labeling locus-specific primers with different
colored dyes.

Multicomponent analysis is the process that separates the five different fluorescent dye
colors into distinct spectral components. The four dyes used in the Identifiler'" Direct
Kit to label samples are 6-FAM™, VIC™, NED"", and PET"" dyes. The fifth dye, LIZ™,
is used to label the GeneScan"" 500 LIZ™ Size Standard or the GeneScan'" 600 LIZ™
Size Standard v2.0.

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on Life Technologies instruments, the fluorescence
signals are separated by a diffraction grating according to their wavelengths and
projected onto a charge-coupled device (CCD) camera in a predictably spaced pattern.
The 6-FAM™ dye emits at the shortest wavelength and is displayed as blue, followed
by the VIC™ dye (green), NED" dye (yellow), PET"" dye (red), and LIZ™ dye
(orange).

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes (Figure
2). The goal of multicomponent analysis is to correct for spectral overlap.

AmpFtSTR™ Identifiler ™ Direct PCR Amplification Kit User Guide 13



1 Chapter 1 Overview
Materials and equipment

Figure 2 Emission spectra of the five dyes used in the Identifiler™ Direct Kit
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Materials and equipment

Kit contents and
storage

The Identifiler™ Direct Kit contains sufficient quantities of the following reagents
for 200 reactions (Part no. 4467831) or 1000 reactions (Part no. 4408580) at

25 pL/reaction.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Table 2 Kit Contents and Storage

Component Description 200 reaction 1000 reaction Storage
AmpFlSTRTM Contains enzyme, salts, dNTPs, 2 tubes, 1 bottle, 125 mL | -15 to -25°C upon
Identifiler™ Direct carrier protein, and 0.04% 1.25 mL each receipt, 2 to 8°C after
Master Mix sodium azide initial use
AmpF(STR™ Contains forward and reverse 2 tubes, 1 bottle, 12.5 mL
Identifiler™ Direct primers to amplify human DNA | 1.25 mL each
Primer Set targets.

AmpF(STR™ Contains 2 ng/uL human female | 1 tube, 50.0 pL 1 tube, 50.0 pL

Identifiler™ Direct
Control DNA 9947A

cell line DNA in 0.04% sodium
azide and buffer.t

See Table 1 on page 10 for
profile.

AmpF(STR™
Identifiler™ Direct
Allelic Ladder

Contains amplified alleles.

See Table 1 on page 10 for a list
of alleles included in the allelic
ladder.

1 tube, 50.0 yL

1 tube, 100 pL

t The Control DNA 9947A is included at a concentration appropriate to its intended use as an amplification control [i.e., to provide confirmation of
the capability of the kit reagents to generate a profile of expected genotype). The Control DNA 9947A is not designed to be used as a DNA
quantitation control and laboratories may expect to see variation from the labelled concentration when quantitating aliquots of the Control

DNA 9947A.

14
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Materials and equipment

Standards for For the Identifiler" Direct Kit, the panel of standards needed for PCR
samples amplification, PCR product sizing, and genotyping are:

e AmpFSTR™ Identifiler Direct Control DNA 9947A — A positive control for
evaluating the efficiency of the amplification step and STR genotyping using the

AmpF(STR™ Identifiler™ Direct Allelic Ladder.

e GeneScan'" 500 LIZ™ Size Standard or GeneScan™ 600 LIZ™ Size Standard
v2.0 — Used for obtaining sizing results. These standards, which have been
evaluated as internal size standards, yield precise sizing results for Identifiler"
Direct Kit PCR products. Order the GeneScan"" 500 LIZ™ Size Standard
(Part no. 4322682) or the GeneScan"" 600 LIZ™ Size Standard v2.0
(Part no. 4408399) separately.

e AmpF(STR™ Identifiler Direct Allelic Ladder — Developed for accurate
characterization of the alleles amplified by the Identifiler'" Direct Kit. The Allelic
Ladder contains most of the alleles reported for the 15 autosomal loci. Refer to
page 10 for a list of the alleles included in the Allelic Ladder.

AmpFtSTR™ Identifiler ™ Direct PCR Amplification Kit User Guide 15
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B Swab substrates: prepare reactions ................ciiiiiiiiiii i 23
B Perform PCR ... 26

Optimize PCR cycle number

Before using the Identifiler™ Direct Kit for the first time, perform a single initial
sensitivity experiment to determine the appropriate cycle number to use during
internal validation studies and operational use of the Identifiler'" Direct Kit. This
experiment accounts for instrument-to-instrument and sample-to-sample variations. If
you are processing multiple sample type and substrate combinations (for example,
buccal samples on treated paper and buccal samples on swabs), perform separate
sensitivity experiments for each sample type and substrate to be used for testing.

The Identifiler ™ Direct Kit is optimized to amplify unpurified:

* Single-source blood samples on treated paper or untreated paper

* Buccal samples on treated paper, untreated paper, or swabs

When amplifying single-source, unpurified samples using the Identifiler™ Direct Kit,
you should expect to see greater variation in peak height from sample to sample than
is expected with purified samples. Careful optimization of the cycle number will help
to minimize this variation.

Select samples and 1. Select 26 of each sample+substrate type. Ensure the selected samples represent a
prepare plates “typical” range of samples analyzed in your laboratory.

IMPORTANT! The number of samples recommended for this study has been
chosen to allow you to complete electrophoresis using a single 96-well plate, thus
minimizing the impact of run-to-run variation on the results. Examples of PCR
and electrophoresis plate layouts are provided on page 107.

2. Prepare the samples and the reactions as described in the protocols later in this
chapter. Prepare sufficient PCR reagents to complete amplification of three
replicate plates.

3. Create three identical PCR plates (see page 107 for a suggested plate layout).

4. Amplify each plate using a different cycle number to determine the optimum
conditions for use in your laboratory. Suggested cycle numbers for different
sample type and substrate combinations are listed below:

AmpFtSTR™ Identifiler ™ Direct PCR Amplification Kit User Guide 17
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Optimize PCR cycle number

Sample Substrate
type Treated paper Untreated paper Swab
Blood 25, 26, 27 cycles | 25, 26, 27 cycles N/A

Buccal 26, 27, 28 cycles 26, 27, 28 cycles 26, 27, 28 cycles

Note: Our testing has not included blood samples on swab substrates. This
sample type is not frequently used for the collection of database or casework
reference samples.

Note: To minimize the effect of instrument-to-instrument variation, use the same
thermal cycler to amplify all three plates. To maximize result quality, prepare and
amplify Plate 1 then repeat for Plates 2 and 3. Do not prepare all three plates

simultaneously.
Determine 1. Run the PCR products on the appropriate CE platform using the recommended
optimum protocol; see Chapter 3, “Perform Electrophoresis” on page 27.
conditions 2. Based on the results of the sensitivity study, select the appropriate PCR cycle

number for future experiments.

Our studies indicate the optimum PCR cycle number should generate profiles with the
following heterozygote peak heights, with no instances of allelic dropout and minimal
occurrence of off-scale allele peaks.

Instrument Heterozygous peak height
31xx 1000-3000 RFU
3500 Series 3000-12,000 RFU

18 AmpFISTR™ Identifiler™ Direct PCR Amplification Kit User Guide



Chapter 2 Perform PCR 2
Treated paper substrates: prepare reactions

Treated paper substrates: prepare reactions

Sample prep * Do not add water to the wells on the reaction plate before adding the punches. If

guidelines your laboratory is experiencing static issues with the paper discs, you may
prepare and dispense the 25 pL reaction mix into the wells of the reaction plate
before adding the punches.

* Make the punch as close as possible to the center of the sample to ensure
optimum peak intensity. Increasing the size of the punch may cause inhibition
during PCR amplification.

¢ For manual punching: Place the tip of a 1.2 mm Harris Micro-Punch on the card,
hold the barrel of the Harris Micro-Punch (do not touch the plunger), gently press
and twist 1/4-turn, then eject the punch in to the appropriate well on the reaction
plate.

¢ For automated punching: Please refer to the User Guide of your automated or
semi-automated disc punch instrument for proper guidance.

Prepare the 1. Add samples to the reaction plate:
reactions
Well(s) Add the following to wells of a MicroAmp™
Optical 96-Well Reaction Plate...
Negative control 1.2 mm blank disc
Test samples 1.2 mm sample disc
Positive control e For 25 cycles 3 pL of Control DNA 9947A
IMPORTANT! Do not @ * For 26 and 27 cycles | 2 pL of Control DNA 9947A

add a blank disc to the

“ e For 28 cycles 1 pL of Control DNA 9947A
positive control well.

Note: The volumes of positive control are suggested amounts and may be adjusted
if peak heights are too high or too low for your optimized cycle number.

2. Calculate the volume of each component needed to prepare the reactions, using

the table below.
Reaction component Volume per reaction
Master Mix 12.5 uL
Primer Set 12.5 uL

Note: Include additional reactions in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The Identifiler Direct Kit has been optimized for a 25-uL. PCR
reaction volume to overcome the PCR inhibition expected when amplifying
unpurified samples. Using a lower PCR reaction volume may reduce the ability
of Identifiler"" Direct Kit chemistry to generate full STR profiles.
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Treated paper substrates: prepare reactions

3. Prepare reagents. Thaw the Master Mix and the Primer Set, then vortex for
3 seconds and centrifuge briefly before opening the tubes or bottles.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2 to 8°C and, therefore, do not require subsequent thawing.
Do not refreeze the reagents.

4. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

5. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

6. Dispense 25 uL of the reaction mix into each reaction well of a MicroAmp™
Optical 96-Well Reaction Plate.

7. Seal the plate with MicroAmp'" Clear Adhesive Film or MicroAmp™"
Optical Adhesive Film.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a
MicroAmp'" compression pad (Part no. 4312639) on top of the plate to prevent
evaporation during thermal cycling. The Veriti'" Thermal Cycler does not
require a compression pad.

8. Centrifuge the plate at 3000 rpm for about 20 seconds in a tabletop centrifuge
with plate holders.

9. Amplify the samples in a GeneAmp"" PCR System 9700 with the silver or
gold-plated silver 96-well block or a Veriti' " 96-well Thermal Cycler or a
ProFlex"" PCR System as described in “Perform PCR” on page 26.

IMPORTANT! The Identifiler " Direct Kit is not validated for use with the
GeneAmp PCR System 9700 with the aluminium 96-well block. Use of this
thermal cycling platform may adversely affect performance of the

Identifiler™ Direct Kit.
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Untreated paper substrates: prepare reactions

Untreated paper substrates: prepare reactions

Sample prep
guidelines

Prepare the
reactions

Make the punch as close as possible to the center of the sample to ensure
optimum peak intensity. Increasing the size of the punch may cause inhibition
during PCR amplification.

If you are using a Bode Buccal DNA Collector”, Bode Buccal Take punch

make the punch as close as possible to the tip of the DNA as close to
™ .

DNA collector to ensure optimum peak intensity. ~ Collector the tip as

Increasing the size of the punch may cause possible

inhibition during PCR amplification.

For manual punching: Place the tip of a 1.2 mm -
Harris Micro-Punch on the card, hold the barrel of

the Harris Micro-Punch (do not touch the plunger),

gently press and twist 1/4-turn, then eject the punch

in to the appropriate well on the reaction plate.

For automated punching: Please refer to the User Guide of your automated or
semi-automated disc punch instrument for proper guidance.

. Add 2 pL of Prep-n-Go'" Buffer (Part no. 4467079) to the sample and negative

control wells in a 96-well plate. Do not add Prep-n-Go"" Buffer to the positive
control wells.

. Add samples to the reaction plate:

Well(s) Add the following to wells of a MicroAmp™
Optical 96-Well Reaction Plate...

Negative control 1.2 mm blank disc

Test samples 1.2 mm sample disc

Positive control e For 25 cycles 3 pL of Control DNA 9947A

IMPORTANT! Do not | ® For 26 and 27 cycles | 2 pL of Control DNA 9947A

addablankdisctothe |y £qr 98 cycles 1 uL of Control DNA 9947A

positive control well.

Note: The volumes of positive control are suggested amounts and may be adjusted
if peak heights are too high or too low for your optimized cycle number.

. Centrifuge the plate to ensure the punches are immersed in the Prep-n-Go ™

Bulffer.
. Calculate the volume of each component needed to prepare the reactions, using
the table below.
Reaction component Volume per reaction
Master Mix 12.5 yL
Primer Set 12.5 L

Note: Include additional reactions in your calculations to provide excess volume
for the loss that occurs during reagent transfers.
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Chapter 2 Perform PCR
Untreated paper substrates:

10.

1.

prepare reactions

IMPORTANT! The Identifiler Direct Kit has been optimized for a 25-uL PCR
reaction volume to overcome the PCR inhibition expected when amplifying
unpurified samples. Using a lower PCR reaction volume may reduce the ability of
Identifiler™ Direct Kit chemistry to generate full STR profiles.

Prepare reagents. Thaw the Master Mix and the Primer Set, then vortex for
3 seconds and centrifuge briefly before opening the tubes or bottles.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2 to 8°C and, therefore, do not require subsequent thawing.
Do not refreeze the reagents.

Pipet the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the reaction mix for 3 seconds, then centrifuge briefly.

Dispense 25 UL of the reaction mix into each reaction well of a MicroAmp"™
Optical 96-Well Reaction Plate.

Seal the plate with MicroAmp" Clear Adhesive Film or MicroAmp ™
Optical Adhesive Film.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a
MicroAmp™ compression pad (Part no. 4312639) on top of the plate to prevent
evaporation during thermal cycling. The Veriti"" Thermal Cycler does not
require a compression pad.

Centrifuge the plate at 3000 rpm for about 20 seconds in a tabletop centrifuge
with plate holders.

Amplify the samples in a GeneAmp"" PCR System 9700 with the silver or
gold-plated silver 96-well block or a Veriti" 96-well Thermal Cycler or a
ProFlex'" PCR System as described in “Perform PCR” on page 26.

IMPORTANT! The Identifiler " Direct Kit is not validated for use with the
GeneAmp PCR System 9700 with the aluminium 96-well block. Use of this
thermal cycling platform may adversely affect performance of the

AmpF(STR™ Identifiler'" Direct PCR Amplification Kit.
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Swab substrates: prepare reactions

Note: Performance verification and optimization experiments for this protocol were
conducted using Copan 4AN6FLOQSwabs™, OmniSwabs, and Puritan swabs air-dried
and stored at room temperature for up to three months.

Sample prep e Detach buccal swab heads from the swab shaft for lysis.

guidelines * Lysis is performed under heated conditions using Prep-n-Go'" Buffer
(Part no. 4471406 for buccal swabs) in either of the following formats:
— 1.5 mL tubes with a heat block (VWR Scientific Select dry heat b lock or
similar)
— 96-well deep-well plate (Part no. 4392904) with an oven and a metal plate
adaptor (Robbins Scientific Model 400 Hybridization Incubator or similar,
Agilent Benchtop Rack for 200 ul Tubes/V Bottom Plates (metal)
Part no. 410094 or similar)

IMPORTANT! Do not use a plastic plate adaptor.

¢ For optimum performance, lysis of a whole swab is recommended. To preserve
the sample, evaluate lysis of a half swab.

Prepare the 1. Preheat the heat block to 90°C or the oven with metal plate adaptor to 99°C.

sample lysate 2. Add 400 uL Prep-n-Go'" Buffer (for buccal swabs, Part. no. 4471406) to 1.5 mL
tubes or the appropriate wells of a 96-well deep-well plate (Part no. 4392904).

3. Into each tube or well, put the entire head of each swab. If you are using tubes,
cap the tubes. Let the tubes or plate stand for 20 minutes in the preheated heat
block or oven to lyse the sample.

4. After 20 minutes, remove the tubes or the deep-well plate from the heat block or
oven.

Note: To minimize the risk of contamination, do not remove the swab heads from
the sample lysate plate before transferring the lysate.

5. Let the lysate stand at room temperature for at least 15 minutes to cool the lysate
(for accurate pipetting).

6. Transfer the sample lysate out of the sample plate into tubes or plates for storage,
then discard the deep-well plate containing the swab heads.

7. Proceed to the next section to prepare the reactions or see “Store the sample
lysate” on page 25.

Prepare the 1. Calculate the volume of each component needed to prepare the reactions, using
reactions the table below.

Reaction component Volume per reaction

Master Mix 12.5 pL

Primer Set 12.5 pL
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Swab substrates: prepare reactions

Note: Include additional reactions in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! This kit has been optimized for a 25-puL PCR reaction volume to
overcome the PCR inhibition expected when amplifying unpurified samples.

Using a lower PCR reaction volume may reduce the ability of Identifiler""
Direct Kit chemistry to generate full STR profiles.

2. Prepare reagents. Thaw the Master Mix and the Primer Set, then vortex for
3 seconds and centrifuge briefly before opening the tubes or bottles.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2 to 8°C and, therefore, do not require subsequent thawing.
Do not refreeze the reagents.

3. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

4. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

5. Dispense 25 uL of the reaction mix into each reaction well of a
MicroAmp" Optical 96-Well Reaction Plate.

6. Add samples to the reaction plate:

Add the following to wells of a MicroAmp™

Wellls) Optical 96-Well Reaction Plate...

Negative control 3 pL of Prep-n-Go™ Buffer

Test samples 3 pL of lysate

Positive control e For 25 cycles 3 pL of Control DNA 9947A
e For 26 and 27 cycles | 2 pL of Control DNA 9947A
e For 28 cycles 1 pL of Control DNA 9947A

Note: The volumes of positive control are suggested amounts and may be adjusted
if peak heights are too high or too low for your optimized cycle number.

7. Seal the plate with MicroAmp'" Clear Adhesive Film or MicroAmp"" Optical
Adhesive Film.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a
MicroAmp™ compression pad (Part no. 4312639) on top of the plate to prevent
evaporation during thermal cycling. The Veriti"" Thermal Cycler does not
require a compression pad.

8. Vortex the reaction mix at medium speed for 3 seconds.

9. Centrifuge the plate at 3000 rpm for about 20 seconds in a tabletop centrifuge
with plate holders.
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Swab substrates: prepare reactions

10. Amplify the samples in a GeneAmp'" PCR System 9700 with the silver or
gold-plated silver 96-well block or a Veriti' " 96-well Thermal Cycler or a
ProFlex"" PCR System as described in “Perform PCR” on page 26.

IMPORTANT! The Identifiler" Direct Kit is not validated for use with the
GeneAmp PCR System 9700 with the aluminium 96-well block. Use of this
thermal cycling platform may adversely affect performance of the
Identifiler Direct Kit.

Store the sample Cap the sample lysate storage tubes or seal the sample lysate storage plate with
lysate MicroAmp " Clear Adhesive Film.

Store the sample lysate as needed:

If you are storing the sample lysate... Then place at...
<2 weeks 2 to 8°C
>2 weeks -15 to -25°C

These storage recommendations are preliminary pending the results of ongoing

stability studies. The effects of multiple freeze-thaw cycles on the lysate have not been

fully evaluated. Therefore, multiple freeze-thaw cycles are not recommended.

AmpFtSTR™ Identifiler ™ Direct PCR Amplification Kit User Guide

25



Chapter 2 Perform PCR
Perform PCR

Perform PCR

1. Program the thermal cycling conditions.

*  When using the GeneAmp PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

e When using the Veriti"" 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti' " 96-Well Thermal Cycler
AmpF(STR™ Kit Validation (PN 4440754).

* When using the ProFlex"" PCR System, refer to the ProFlex"" PCR System Kit
Validation User Bulletin (Pub. no. 100031595) for more information.

-y w - 1-
in:z:)t;aﬁlon Optimum cycle number Final Final
step Denature Anneal Extend extension hold
HOLD CYCLE HOLD HOLD
95°C 94°C 59°C 72°C 60°C 4°C
11 min 20 sec 2 min 1 min 25 min oo

T Determine the optimum cycle number for your laboratory according to the instructions on page 17.

2. Load the plate into the thermal cycler and close the heated cover.
3. Start the run.

4. On completion of the run, store the amplified DNA.

If you are storing the DNA... Then place at...
<2 weeks 2 to 8°C
>2 weeks -15 to -25°C

IMPORTANT! Protect the amplified products from light.
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Chapter 3 Perform Electrophoresis

Allelic ladder requirements

Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples.

Number of One .
. L Number of samples per allelic
Instrument allelic ladders injection
ladder(s)

to run equals
3100-Avant or 3130 | 1 per 4 injections | 4 samples 15 samples + 1 allelic ladder
3100 or 3130x{ 1 per injection 16 samples | 15 samples + 1 allelic ladder
3500 1 per 3 injections | 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples 23 samples + 1 allelic ladder
3730 2 per injection 48 samples | 46 samples + 2 allelic ladders

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between both single- and multiple-capillary runs
(with larger size variations seen between samples injected in multiple-capillary runs).
We recommend the above frequency of allelic ladder injections, which should account
for normal variation in run speed. However, during internal validation studies, verify
the required allelic ladder injection frequency to ensure accurate genotyping of all
samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the
samples, because size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and electrophoretic
conditions.
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Section 3.1 3100/3100-Avant and 3130/3130xl instruments
Set up the 3100/3100-Avant and 3130/3130x!l instruments for electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x!
instruments

Set up the 3100/3100-Avant and 3130/3130x! instruments for
electrophoresis

Reagents and parts

Appendix B, “Ordering Information” on page 103 lists the required materials not
supplied with the Identifiler™ Direct Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Electrophoresis
software setup and

The following table lists data collection software and the run modules that can be

used to analyze Identifiler'" Direct Kit PCR products. For details on the procedures,
refer to the documents listed in the table.

reference
documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 1.0 Windows™ GeneScan36Avb_DyeSetG5Module = 3700/3100-Avant Genetic Analyzers
Biosystems™ NT Injection condition: 3 kV/5sec Protocols for Processing AmpF(STR™
3100-Avant . PCR Amplification Kit PCR Products
G5600v2.DAnalysis.gsp User Bulletin (Part no. 4332345)
Applied 2.0 Windows™ HIDFragmentAnalysis36_POP4_1 | 3100/3100-Avant Genetic Analyzers
Biosystems™ 2000 Injection condition: 3kV/10 sec Using Data Collection Software v2.0,
3100 Dye Set G5 Protocols for Processing AmpF(STR™
PCR Amplification Kit PCR Products
User Bulletin (Part no. 4350218)
1.1 Windows™ GeneScan36vb_DyeSetG5Module  3700/3100-Avant Genetic Analyzers
NT Injection condition: 3kV/10 sec Protocols for Processing AmpF(STR™
. PCR Amplification Kit PCR Products
G5600v2.DAnalysis.gsp User Bulletin (Part no. 4332345)
Applied 3.0t Windows™ HIDFragmentAnalysis36_POP4_1 | Applied Biosystems ™ 3130/3130x!
Biosystems™ XP Injection conditions: Genetic Analyzers Using Data Collection
3130/3130x( Software v3.0, Protocols for Processing

- 3130 = 3 kV/5 sec
- 3130x( = 3 kV/10 sec

e Dye Set G5

AmpFISTR™ PCR Amplification Kit PCR

Products User Bulletin (Part no.
4363787)

+ We conducted validation studies for the Identifiler™ Direct Kit using this configuration.
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3 Chapter 3 Perform Electrophoresis
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130x! instruments

Prepare samples for electrophoresis on the 3100/3100-Avant or
3130/3130x! instruments

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di'"" Formamide and size standard needed to prepare
the samples:

Reagent Volume_ per Reagent Volume_ per
reaction reaction
GeneScan™ 500 0.3 uL OR GeneScan™ 600 0.5 pL
LIZ™ Size Standard LIZ™ Size
Standard v2.0
Hi-Di™" Formamide 8.7 uL Hi-Di"™ Formamide 8.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each well of a MicroAmp"" Optical 96-Well Reaction Plate, add:
* 9 uL of the formamide:size standard mixture
¢ 1 pL of PCR product or Allelic Ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

5. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Prepare the plate assembly on the autosampler.

Y ® N o

Start the electrophoresis run.
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Section 3.2 3500/3500xL instruments 3
Set up the 3500/3500xL instruments for electrophoresis

Section 3.2 3500/3500xL instruments

Set up the 3500/3500xL instruments for electrophoresis

Reagents and parts Appendix B, “Ordering Information” on page 103 lists the required materials not
supplied with the Identifiler'" Direct Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Electrophoresis The following table lists data collection software and the run modules that you can

software setupand  use to analyze Identifiler'" Direct Kit PCR products. For details on the procedures,
refer to the documents listed in the table.
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reference
documents
Genetic Data_ Operating .
Collection Run modules and conditions References
Analyzer System
Software
Applied 3500 Data = Windows™ e HID36_POP4 Applied Biosystems™ 3500/
Biosystems™ | Collection | XP Injection conditions: 1.2kV/15 sec 3500xL Genetic Analyzer User
3500 510féware or « Dye Set G5 Guide (Part no. 4401661)
Applied Windows s HID36_POP4 3500 and 3500xL. Genetic
Bi ™ M L . Analyzers Quick Reference Card
losystems Vista Injection conditions: 1.2kV/24 sec (Part no. 4401662)
3500xL )

e Dye Set G5

Prepare samples for electrophoresis on the 3500/3500xL
instruments

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di™ Formamide and GeneScan™ 600 LIZ™ Size
Standard v2.0 needed to prepare the samples:

Reagent Volume per reaction
GeneScan™ 600 LIZ™ Size Standard v2.0 0.5 uL
Hi-Di™ Formamide 8.5 L

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.
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Chapter 3 3500/3500xL Instruments

Prepare samples for electrophoresis on the 3500/3500xL instruments

2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each well of a MicroAmp"" Optical 96-Well Reaction Plate, add:
* 9 uL of the formamide:size standard mixture
* 1 uL of PCR product or Allelic Ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

5. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

Heat the plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Place the sample tray on the autosampler.

©° ® N o

Start the electrophoresis run.
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Section 3.3 3730 instrument

Set Up the 3730 instrument for electrophoresis

Section 3.3 3730 instrument

Set Up the 3730 instrument for electrophoresis

Reagents and parts Appendix B, “Ordering Information” on page 103 lists the required materials not
supplied with the Identifiler'" Direct Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.
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Electrophoresis The following table lists data collection software and the run modules that you can

software setupand  use to analyze Identifiler'" Direct Kit PCR products. For details on the procedures,
refer to the documents listed in the table.

reference
documents
Operatin Data
P 9 collection Run module References
system
software
Windows XP 3.07 e GeneMapper_36_POP7 Applied Biosystems™ 3730 DNA Analyzer
e Dye Set G5_RCT Human Identification Validation Report*

t+ We conducted concordance studies for the Identifiler™ Direct Kit using this configuration.
T Contact your sales or support representative to obtain a copy of the 3730 DNA Analyzer Human Identification Validation Report.

Prepare samples for electrophoresis on the 3730 instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume_ per Reagent Volume_ per
reaction reaction
GeneScan™ 500 0.3 L OR GeneScan™ 600 0.5 uL
LIZ™ Size Standard LIZ™ Size
Standard v2.0
Hi-Di™ Formamide 8.7 uL Hi-Di™ Formamide 8.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.
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3 Chapter 3 3730 Instrument
Prepare samples for electrophoresis on the 3730 instrument

2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each well of a MicroAmp"" Optical 96-Well Reaction Plate, add:
* 9 uL of the formamide:size standard mixture
* 1 uL of PCR product or Allelic Ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

5. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

Heat the plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Place the sample tray on the autosampler.

©° ® N o

Start the electrophoresis run.
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Section 4.1 GeneMapper'" ID Software

Overview of GeneMapper™ ID Software

Instruments

Before you start

GeneMapper " ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the Data Collection Software stores information for each

sample in an .fsa file. Using GeneMapper " ID Software v3.2.1 software, you can then
analyze and interpret the data from the .fsa files.

Refer to “Instrument and software overview” on page 13 for a list of compatible
instruments.

When using GeneMapperTM ID Software v3.2.1 to perform human identification
(HID) analysis with AmpF(STR™" kits, be aware that:

e HID analysis requires at least one allelic ladder sample per run folder. Perform

the appropriate internal validation studies if you want to use multiple ladder
samples in an analysis.

For multiple ladder samples, the GeneMapper'" ID Software calculates allelic bin
offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.
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Set up GeneMapper™ ID Software for data

analysis

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

Alleles that are not in the AmpF(STR™ Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory’s protocol.

Set up GeneMapper™ ID Software for data analysis

File names

Before using the
software for the
first time

Import panels and
bins

36

The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com.

To analyze sample files (.fsa) using GeneMapper " ID Software v3.2.1 for the first time:

Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 36.

Create an analysis method, as explained in “Create an analysis method” on
page 40.

Create a size standard, as explained in “Create a size standard” on page 45.
Define custom views of analysis tables.

Refer to the GeneMapper™ ID Software Versions 3.1 and 3.2 Human Identification
Analysis Tutorial (Part no. 4335523) for more information.

Define custom views of plots.
Refer to the GeneMapper™ ID Software Versions 3.1 and 3.2 Human Identification
Analysis Tutorial (Part no. 4335523) for more information.

To import the Identifiler™ Direct Kit panel and bin set from the Life Technologies
web site into the GeneMapper'" ID Software v3.2.1 database:

1.

Download and open the file containing panels and bins:

a. From the Support menu of www.lifetechnologies.com, select
Support » Software Downloads, Patches & Updates » GeneMapper'" ID
Software v 3.2 » Updates & Patches, and download the file Identifiler
Direct Analysis Files GMID.

b. Unzip the file.
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Section 4.1 GeneMapper™ ID Software
Set up GeneMapper™ ID Software for data analysis

2. Start the GeneMapper " ID Software, then log in with the appropriate user name
and password.

IMPORTANT! For logon instructions, refer to the GeneMapper'" ID Software
Version 3.1 Human Identification Analysis User Guide (Part no. 4338775).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels and bins:

a. Select Panel Manager in the navigation pane.

? Panel Manager
File Edit Bins “iew

b. Select File » Import Panels to open the
Import Panels dialog box.

c. Navigate to, then open the Identifiler
Direct Analysis Files GMID folder that
you unzipped in step 1 on page 36.

=5 N N NN Il

B Panel Manager
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5. Select IdentifilerDirect_GS500_Panels_v1.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, IdentifilerDirect_GS500_v1. This folder contains the panel and
associated markers.

Lookin | Identifiler Direct Analysis Files GMID =] £

IderitifilerDirect_GS500_Binzs_wi

File name: IldentifiIerDirect_GSSDEI_PaneIS_\-"I tut Iimport |
Files of type: IA" Files ﬂ Cancel |

6. Import IdentifilerDirect_GS500_Bins_v1.txt:
a. Select the IdentifilerDirect_GS500_v1 folder in the navigation pane.

E: Panel Manager
File Edit Bins ‘iew

b. Select File » Import Bin Set to open the
Import Bin Set dialog box.

, . ><||||||:|1|||||l||.|.u||a.nsa
c. Navigate to, then open the Identifiler —
Direct Analysis Files GMID folder. | il

Ex B ci=rtifilerDirec
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analysis

d. Select IdentifilerDirect_GS500_Bins_v1.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
IdentifilerDirect_GS500_Panels_v1 folder.

Lookin | Identifier Direct Analysis Files GMID = £F

File name: IIdentifilerDired_GSSDD_Bins_v1 tt Ittt |
Filez of type: IAIIFiIes LI Cancel |

7. View the imported panels in the navigation pane:

a. Double-click the IdentifilerDirect_GS500_v1 folder to view the
IdentifilerDirect_GS500_Panels_v1 folder.

b. Double-click the IdentifilerDirect_GS500_Panels_v1 folder to display the
panel information in the right pane.

Fil=  Edit Bins View

i || Bl (R || .l. ||Bin Set: IldentifiIerDired_GSSUD_Bins...j| | LS R |||i
ldertifilerDirect_GS500_v1 d Mfarkcer Mime Dye Color | Bin Sdze | Blax 3ize | Control Alleles

Idertitiler 1 pestivs Jewe  [11eo [1ass |13
—Daz17a 2 |D21s11 blue 1845 |2475 |30
[~ D211 DTS20 b 2510|2985  [10,11
— D7s820 3 H= : : '
| csriro 4 |CsF1PO blue  |30212 |34863 |1042
— 0351358 5 |D3s1358 green (380 1480|1445
— THO g |THOY green 1590 |2050 893
[ L3S D135H7 20565 |25046 |11
- Dess53 7 gréen : :
I g |D1e3s53a green  |2553 (30181 |1142
— 193433 9 |D2s1338 green  |3045 (3703 |19,23
A, 10 |D185433 yellow 1010|1480 [14.15
—TPOX
| orasst 11 | yellow 1510|2135 1748
| aMEL 12 |TPOX yellw  |21630 |260.39 |8
— 53818 A 113 |eess yellow  |26449 (3500|1544
B —FGA | _’|L 14 | AMEL red 1060 [1140 [«
— 15 |D55818 red 1280 1800 |11
—EReference Samples 16 |FGA red 0625|3600 (2324
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Set up GeneMapper™ ID Software for data analysis

8. Select D8S1179 to display the Bin view for the marker in the right pane.

anel Manager
Edit Bins Wiew

B > || B B W || | [JRLL | |BinSet IldentifiIerDired_GSSDD_Elins...L” | . B B CE M |||_|

File:

IdentifilerDirect_G=500_w1
IJ:'I—ﬁIdentifilerDirect_GSSDD_Panels_v'l
7 i3 =] 10 11 12 13
1.0
— 021511
—D¥S820
— CSF1PO 0.9
— 0351358
— THM
—D1asmT o8
— CrE5539
— 02313358 07
— 195433
A,
— TPOX 05
— D855
— AMEL
— DESE3 | 0.3
— FeA4 &
‘ﬂv I LI_ 04
—=JReference Samples
03
0z

9. Click Apply, then OK to add the Identifiler" Direct Kit panel and bin set to the
GeneMapper' " ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels
and bins are not imported into the GeneMapper'" ID Software database.

AmpFtSTR™ Identifiler ™ Direct PCR Amplification Kit User Guide 39

@)
o
=
(0]
<
Q
ke
ie]
(0]
Ny
&)
(7]
[°]
=+
<
(V)
=
o




Chapter 4 Analyze Data
Set up GeneMapper™ ID Software for data

analysis

Create an analysis  To create an HID analysis method for the Identifiler" Direct Kit.

method
1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
E:!GeneMapper Manager =
[Marne Last Saved ner Instrurment Analysis Type Description
Defautt 2011-02-2213:49:0 Microzatelite -
HID_Advanced 2009-06-15 16:22:2 | amid HID
HID_Clazsic 2007-05-06 10:03:0 | amic HID -
7] { =l

Mew... Open... SAVEIAS.. Iport... Export... Delete |

2. Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.

3. Select HID and click OK to open the Analysis Method Editor with the General tab
selected.

4. Enter the settings shown in the figures on the following pages.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

5. After you enter settings in all tabs, click Save.

General tab |

settings General | alele | Peak Detector | Peak Qualty | Guaity Fiags |

~&nalyziz Method Description

Mame; IderitifilerDirect_AnalysizMethod w1

Description: ﬂ

Inztrument: I

Analysizs Type: HIC:

Ok Cancel
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Set up GeneMapper™ ID Software for data analysis

In the Name field, either type the name as shown for consistency with files

supplied with other AmpF(STR™ kits, or enter a name of your choosing. The
Description and Instrument fields are optional.

Allele tab settings x|
General N'B'BI Peak Detector I Peak Cluality I Gty Flagsl
BinSet [ldertiflerDirect_GSS00_Bins_v1 =l o
3
[ use marker-specific stutter ratioif available g§>
Warker Repest Type : Tri Tetra Perita Hexa §
Cut-off Yalue Joo Joz Joo Joo _
Minus., Ratio oo oo oo oo 8
MinuzA Distance From |0.0 0.0 0.0 0.0 %
To oo D0 D0 D0 H
Minus Stutter Ratio Jno Jno Jno Jno @
Minus Stuter Distance From  [0.0 J3.25 Joo Joo
To oo Ja7s oo oo
Plus Stutter Ratio Do Do Do Do
Pluz Stutter Distance From |0.0 0.0 0.0 0.0
To |00 Jno Jno Jno
Arnelogenin Cutaft IF

Range Fitter ... | Factary Defautts |

Ok | Cancel |

* In the Bin Set field, select the IdentifilerDirect_GS500_Bins_v1 bin set imported
previously and configure the stutter distance parameters as shown.

* GeneMapper " ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

* Specify the stutter ratio:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the
IdentifilerDirect_GS500_Panels_v1 file, select the “Use marker-specific
stutter ratio if available” check box (selected by default). Perform
appropriate internal validation studies to determine the appropriate filter
setting to use.
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Peak Detector tab x

settings
9 General I Allgle  Peak Detector I Peak Quslity I Quiality Flags I

Peak Cetection Algorithm: IAdvanced it I

Ranges "Peak Detection Perf
. . errorm
Arialysis _I IS'Z'”Q _I Peak Ampltude Thresholds: internal
Full Range ~ Al Sizes W . .
— B: | R: | validation
Start Pt |0 Start Sized0 a I o I studies to
Stop Pt [10000 Stop Zize:|1000 ’ |— ) j determine
; - \" settings
—=moothing and Baselining—————
Min. Peak Half Width: |2 pts
Smoathing ™ Mohe _ I_
o Lt Polyromial Degree: 3
' Heawy Peak Window Size: 15 pts
Baseling YWindow: |51 pts et WA
Peak Start: ID.EI
~Size Calling Method Peak End: ID.EI
" 2nd Orcer Lesst Sguares
" Zrd Crder Least Soquares
" Cukic Spline Interpolation
(% Local Southern Methad
" Global Southern Method

Factary Defautts |

CK | Cancel |

IMPORTANT! Perform the appropriate internal validation studies to determine
the peak amplitude thresholds for interpretation of Identifiler" Direct Kit data.

Fields include:
* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although

GeneMapper " ID Software displays peaks that fall below the specified amplitude
in electropherograms, the software does not label or determine the genotype of

these peaks.

* Size calling method — The Identifiler" Direct Kit has been validated using the
Local Southern sizing method. Before using alternative sizing methods, perform

the appropriate internal validation studies.
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3500/3500xL and 3730 data

* 3500/3500xL and 3730 data: Overall peak heights for the data are approximately 3
times higher than peak heights obtained for samples run on the 31xx series
instruments. Evaluate validation data carefully to determine the appropriate Peak
Amplitude Thresholds for reliable analysis.

* 3730 data only: Due to differences in the resolution of peaks using POP-7"
polymer versus POP-4" polymer, reduce the Peak Window Size setting in
GeneMapper " ID Software from 15 pts to 11 pts to obtain accurate genotyping
results.

¢ For more information:

- Refer to User Bulletin: Applied Biosystems' " 3500/3500xL Genetic Analyzer:
Protocols for Analysis of AmpFISTR™ PCR Amplification Kit PCR Products and
Validation Summary (Part no. 4469192)

— Contact your sales or support representative to obtain a copy of the 3730
DNA Analyzer Human Identification Validation Report
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Peak Quality tab

. Analysis Method Editor - HID x|
settings _ _
Generall Allele I Peak Detector  Peak Quality | Guality Flagsl
~Signal level
el =5 Perform
Homozygous min peak height internal
Heterozygous min peak height Va“d_at'on
studies to
~Heterozygote balance determine
i peak height ratio Settlngs

Peak morphaology

Max peak width (hasepairs)

~Pull-up peak
Puill-up ratio

Allele number

Liiam

s expected alleles

Factary Defaults |

Ok | Cancel |

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds and the
minimum peak height ratio threshold that allow for reliable interpretation of
Identifiler™ Direct Kit data.
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Quallty Fla gs tab Analysis Method Editor - HID x|
settings General | Allele | Peak Detector | Pesk Qualty Quaity Flags |
Gyality weights are betvween 0 and 1.
Euslty Flag Settings
Spectral Pull-ug ID.S Control Concordance |1 il
Broad Peak ID.S Loy Peak Height 0.3
Ot of Bin Allele |D.8 Off-scale 0.8
Cverlap ID_S Peak Height Ratio 03
~Pa Threshold:
Pass Range: Loy Guality Ranoe:
Sizing Guiality: Frarm ID.?S to1.0 From 0.0 to ID.25
Genotype Gualty: Framn IIj 73 ta1.0 Fram00to  [0.25
Factary Defaults |
QK | Cancel |

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform the appropriate internal validation studies
to determine the appropriate values to use in your laboratory.
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Set up GeneMapper™ ID Software for data analysis

Create a size The size standards for the Identifiler" Direct Kit use the following size standard

standard peaks in their definitions:

GeneScan™ 500 LIZ™ Size Standard
peak sizes

GeneScan™ 600 LIZ™ Size Standard
v2.0 peak sizes

75,100, 139, 150, 160, 200, 300, 350, 400, and
450

80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
240, 250, 260, 280, 300, 314, 320, 340, 360,
380, 400, 414, 420, 440 and 460

Note: The 250-nt and the 340-nt peak in the GeneScan'" 500 LIZ" Size Standard are
not included in the size standard definition. These peaks can be used as an indicator

of precision within a run.

To create the size standard for the Identifiler™ Direct Kit:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

[#)GeneMapper Manager =
Projects | Analysis Methods | Table Settings | Pict Settings | Matrices  Size Standards |

[Marne Last Saved ner Type Description

377 _G5_HD_G5500 2004-05-28 11:34:3 | amid Basiciidvanced Factory Provided [«

377 _F_HID_G=500 2004-05-28 11:34:3 | amid Basiciidvanced Factory Provided

CE_G5_HID_GS500 2004-05-28 11:34:3 | amid Basiciidvanced Factory Provided

CE_F_HD_G=500 2004-05-28 11:34:3 | amid Basiciidvanced Factory Provided [

ey | Open... | Save A | Import... | Export... |

Done |

2. Select the Size Standards tab, then click New.
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Chapter 4 Analyze Data
Analyze and edit sample files with GeneMapper™ ID Software

3. Enter a name as shown below or enter a name of your choosing. In the Size
Standard Dye field, select Orange. In the Size Standard Table, enter the peak sizes

specified in on page 45. The example below is for the GeneScan™" 500 LIZ™ Size
Standard.

[# )size Standard Editor x|

Edit

—=ize Standard Description

Mame: ICE_GS_IdentifilerDirect_GSSDU

Description:

Size Standard Dye: IOrange LI

Size Standard Table

Size in Bazepairs
1 750 &

2 (1000

3 1390

4 [1s00 |

5 [160.0

6 (2000

7 (3000

a |[3=0.0

9 4000
10 (4500 ﬂ
Ok | Cancel |

Analyze and edit sample files with GeneMapper™ ID Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above. If you named the settings
differently, select the names you specified.

Parameter Settings

Sample Type Select the sample type.

Analysis Method IdentifilerDirect_AnalysisMethod_v1 (or the name of the analysis
method you created)

Panel IdentifilerDirect_GS500_Panels_v1
Size Standard CE_G5_ldentifilerDirect_GS500 (or the name of the size standard you
created)

For more information about how the Size Caller works, refer to the ABI PRISM™"
GeneScan"" Analysis Software for the Windows NT'" Operating System Overview of
the Analysis Parameters and Size Caller User Bulletin (Part no. 4335617). For

additional information about size standards, refer to the GeneMapper™ ID
Software Version 3.1 Human Identification Analysis User Guide (Part no. 4338775).
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Examine and edit a project

3. Click I» (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis. During a run:

* The status bar displays the progress of analysis as both:

— A completion bar extending to the right with the percentage completed

indicated

— With text messages on the left

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Genotypes tab becomes available after analysis.

[? |GeneMapper ID ¥3.2.1 - *IdentifilerDirect_Example - gmid Is Logged In
Fil=  Edit

Analysis  Wiew Tools Help
e G| B e W0 LE | e & | |rabessting] |Ho rane ~B| & -
[E-EdProject Samples | Genotypes I
- Tidertifler Di Status |Sample File Sample Marme Sample Type | Analysis Method Panel Size Standard
1 h Identifiler _FTA_01_AD1 fsa Iddentifiler _FTa_01 Sample IdertifilerDirect_Analysishethod_w1 IdentifilerDirect_GS500_Panels_w1 CE_G5_ldertifiler
2 h Idertifiler _FTA_02_BO1 fza Iddentifiler _FTa_02 Sample IdertifilerDirect_Analysishethod_w1 IdentifilerDirect_GS500_Panels_w1 CE_G5_ldertifiler
3 h Idertifiler _FTA_03_C01 fza Iddentifiler _FTa_03 Sample IdertifilerDirect_Analysishethod_w1 IdentifilerDirect_GS500_Panels_w1 CE_G5_ldertifiler
4 h Idertifiler_FTA_04_D01 fza Iddentifiler _FTa_04 Sample IdertifilerDirect_Analysishethod_w1 IdentifilerDirect_GS500_Panels_w1 CE_G5_ldertifiler
5 h Identifiler _FTA_05_E01 fza Iddentifiler _FT&_05 Sample IdertifilerDirect_Analysishethod_w1 IdentifilerDirect_GS500_Panels_w1 CE_G5_ldertifiler
B h Idertifiler _FTA_O6_FO1 fza Iddentifiler _FTa_06 Sample IdertifilerDirect_Analysishethod_w1 IdentifilerDirect_GS500_Panels_w1 CE_G5_ldertifiler
7 h Ladder_G01 fza Lacider Allelic Ladder | IdentifilerDirect_Analysistethod_w1 IdentifilerDirect_GS500_Panels_w1 CE_G5_ldertifiler
g h Ladder_G02 fza Lacider Allelic Ladder | IdentifilerDirect_Analysistethod_w1 IdentifilerDirect_GS500_Panels_w1 CE_G5_ldertifiler
7]
B = E
Progress Status ... 0%

Examine and

edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of

the Project window (assuming the analysis is complete).

For more information

For details about GeneMapper'" ID Software features, allele filters, peak
detection algorithms, and project editing, refer to:

o GeneMapper™ ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial

(Part no. 4335523)

o GeneMapper™ ID Software Version 3.1 Human Identification Analysis User Guide (Part

no. 4338775)

e Installation Procedures and New Features for GeneMapper™ ID Software Software
Version v3.2 User Bulletin (Part no. 4352543)
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Chapter 4 GeneMapper™ ID-X Software

Overview of GeneMapper™ ID-X Software

Section 4.2 GeneMapper™ ID-X Software

Overview of GeneMapper™ ID-X Software

Instruments

Before you start

48

GeneMapper " ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample
in a .fsa or .hid file. Using GeneMapper'" ID-X Software, you can then analyze and
interpret the data from the .fsa files (GeneMapper'" ID-X Software v1.0.1 or higher)
or .hid files (GeneMapper" ID-X Software v1.2 or higher).

Refer to “Instrument and software overview” on page 13 for a list of compatible
instruments.

™

When using GeneMapper ~ ID-X Software v1.0.1 or higher to perform human
identification (HID) analysis with AmpF(STR™ kits, be aware that:

¢ HID analysis requires at least one allelic ladder sample per run folder. Perform
the appropriate internal validation studies if you want to use multiple ladder
samples in an analysis.
For multiple ladder samples, the GeneMapper " ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a run
folder.

* Allelic ladder samples in an individual run folder are considered to be from a
single run.
When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

™

¢ Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

¢ Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

* Alleles that are not in the AmpF(STR™ Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory protocol.
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Set up GeneMapper™ ID-X Software for data analysis

File names The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.appliedbiosystems.com.

Before using the Before you use GeneMapper' " ID-X Software to analyze data files (GeneMapper'" ID-
software for the X Software v1.0.1 or higher for .fsa files, GeneMapper™ ID-X Software v1.2 or higher
first time for .hid files):

2

* Import panels, bins, and marker stutter into the Panel Manager, as explained in
“Import panels, bins, and marker stutter” on page 49.

¢ Create an analysis method, as explained in “Create an analysis method” on page
53.

¢ Create a size standard, as explained in “Create a size standard” on page 58.
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* Define custom views of analysis tables.
Refer to the GeneMapper™ ID-X Software Version 1.0 Getting Started Guide
(Part no. 4375574) for more information.

¢ Define custom views of plots.
Refer to the GeneMapper™ ID-X Software Version 1.0 Getting Started Guide
(Part no. 4375574) for more information.

Import panels, To import the Identifiler ™ Direct Kit panel, bin set, and marker stutter from the
bins, and marker Life Technologies web site into the GeneMapper ' ID-X Software database:

stutter 1. Download and open the file containing panels, bins, and marker stutter:

a. From the Support menu of www.lifetechnologies.com, select
Support » Software Downloads, Patches & Updates » GeneMapper' " ID-X
Software » Updates & Patches, and download the file Identifiler Direct
Analysis Files GMIDX.

b. Unzip the file.

2. Start the GeneMapper " ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper™ ID-X
Software Version 1.0 Getting Started Guide (Part no. 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

#* Panel Manager

b. Select File » Import Panels to open the Import

: Fle Edt Bns View el
Panels dialog box. = =T S SeW =R

OX |WFH N

B .. Panzl Manager

|

c. Navigate to, then open the Identifiler Direct
Analysis Files GMIDX folder that you unzipped
in step 1.
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5. Select IdentifilerDirect_GS500_v1X, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel

Manager “IdentifilerDirect_GS500_Panels_v1X". This folder contains the panel
and associated markers.

#* Import Panels

My Recent
Documents

My Documents

9

My Computer

Lookin: |[2) Identifler Direct Analysis Files GMIDX v 2 2EE

X

[Z] 1dentifilerDirect_GSS00_Bins_v1X.bxk

B IdentifilerDirect_GS500_Panels_v1.kxt
[Z] 1dentifilerDirect_GSS00_Stutter_v1X.bxk
[Z] ReadMe_IDDirect_vix.txt

File name: [dentfilerDirect_GSS00_Panels_viX.txt | [ Impart ]

Files of bype: | Al Files v | Cancel

6. Import IdentifilerDirect_GS500_Bins_v1X.txt:

a. Select the IdentifilerDirect_GS500_Panels_v1X folder in the
navigation pane.

« Panel Manager

File Edit Bins Wiew Help

w X | lFEN B ™  cn Set:‘IdentiFiIerDirect_GSSDEl_Bins_vlx ~ | i
B---%Panel Manager _Epm1 Harne G
é'""@HMDFLSTR_F‘aneIs_le i entifilerDirect_GSS00_Panels_v 1 |null
88 [dentifilerDire

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then open the Identifiler Direct Analysis Files GMIDX folder.
d. Select IdentifilerDirect_GS500_Bins_v1X.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
IdentifilerDirect_GS500_v1X folder.

»* Import Bin Set

Laak in: |E:|Identiﬁler Direct Analysis Files GMIDX v| T EE
L B IdentifilerDirect_GS500_Bins_v1X.txt
| [Z] 1dentifilerDirect_GS500_Panels_w1x bxt
My Recent Ej IdentifilerDirect_GS500_Stutter w1 txt
Documents [Z] ReadVe_IDDirsck_vix.bxt
Desktop
{ s
My Documents
g! Filz name: | IdentifilerDirect_G5500_Bins_vIX.bxt | [ import |
My Computer | Files of bype: |AII Files v | [W]
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7. View the imported panels in the navigation pane:
a. Double-click the IdentifilerDirect_GS500_v1X folder.

b. Double-click the IdentifilerDirect_GS500_Panels_v1X folder to display the
panel information in the right pane and the markers below it.

« Panel Manager
File Edit Bins Wiew Help

. = @)
- o | B ™ BinSet: | IdentifilerDirect_GS500_Eins_vi v| | %
= o2, Panel Manager |Bfiker Hame | Dye Color |Min Size  |Mhx Sime | Corrol Alleles §
L[ E)AmpFLSTR_Panels_w1¥ 1 [eaiies Bloe 118.0 [183.5 |13 o)
H e}
= l:ﬁlntiﬁlerDirect_GSEDU_v 1% > |Dzlsil Blue 1845 247.5 a0 @
Identifile 2
i 3 |D7sazD Bue (2510 [298.5 (10,11 S
D21511 4 |CSFIPO Blue 302.12 |348.63 [10,12 <
- DF5620 5 [D351358 Green |98.0  [148.0  [14,15 o
- £SF1PO & |THOL Green |159.0 (2050 |g,9.3 g"
- D351358 3
7 [D135317 Green |205.65 |250.16 |11 L
- THO1 @
D135317 5 |DI65539 Green  |255.3  [301.81 [11,12
- D165539 9 [D251338 Green  |304.8  [370.31 [19,23
- D251338 10 |D195433 vellow |101.0  |148.0  |14,15
- D195433
e 11 |vwa vellow [151.0  [213.5 [17.18
PO 12 [TPOX vellow  |216.99 |280.99 |3
- M1 RSE1 12 IN1RSE1 Yellrw A4 49 AE0.N i6.19

8. Select D8S1179 to display the Bin view for the marker in the right pane.

« Panel Manager.

File Edit Bins View Help

B § W OW | E | ense: |IdentiFiIerDirect_GSSDD_Bins_v1>< v| WLyESE BEEBEBEEE @
= g3y Panel Manager
) AMPFLSTR,Panels_v1X i H 8 a o 11 1z 13 14 15 s 17 18 gl =
erDirect_G5500_Panels_w1x ns
‘D211l e
- D7SE20 i
- CSFIPO
- D351358 0§
- THOL
£ 0135317 05
- D165539
- D251338 o
£ 0195433 55
il
- TROY, 0z
- 018351
- AMEL 04
- DES518 -
RGH 113 115 117 119121 128 125 127 129 131 133 135 137 139 141 145 145 147 149 151 153 155 157 159 161 163 165 167 169 171 173175 177 178 181 183
e Las1179
------ i Reference Samples 4
M 17336 Y2 0.31

[ OF H Cancel H Apply H Help ]
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9. Import IdentifilerDirect_GS500_Stutter_v1X.txt:
a. Select the IdentifilerDirect_GS500_v1 folder in the navigation panel.

= Panel Manager
File Edit Bins ‘iew Help

w' X | iFE N N = BinSet:‘IdentiFiIerDirect_GSSElD_Bins_vlx sl
B'"d%bpane' Manager _iPanel Harne Corroment
;—----[hnmpFLSTR_PaneIs_le 1 entifilerDirect_=3500_Panels_v1x |null

[E=8 i [clertifilerDirect

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog
box.

c. Navigate to, then open the Identifiler Direct Analysis Files GMIDX folder.
d. Select IdentifilerDirect_GS500_Stutter_v1X.txt, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the IdentifilerDirect_GS500_Bins_v1X folder.

#* Import Marker Stutter

Look in: |E:| Identifiler Direct Analysis Files GMIDX v| > 'F_‘?||E

E Ej IdentifilerDirect_GS500_Bins_w13.kxt

IE:I IdentifilerDirect_GS500_Panels_w1X bxt

My Recent B IdentifilerDirect_GS500_Stutter_v1X.txt
Documents [Z] ReadMe_IDDirect_v1x.bxt
Desktop

"9

My Documents

=

File pame: | dentifilerDirect_GS500_Stutter_v1X.bxt | [ mpart |

My Computer | Files of Eype: |.p.|| Files v| Cancel

10. View the imported marker stutters in the navigation pane:

a. Select the IdentifilerDirect_GS500_v1X folder to display its list of markers
in the right pane.

b. Double-click the IdentifilerDirect_GS500_v1X folder to display its list of
markers below it.
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c. Double-click D165539 to display the Stutter Ratio & Distance view for the
marker in the right pane.

« Panel Manager
File Edit Bins Yiew Help

al 3 o N | Il ™ | Binset: .IdentifilerDirect_GSSElD_Bins_vlx v| e NN BEEEBERERI
= g, Pared 1 - i _
%.gimpﬁ;ﬁ_pands_m || Flease enter the stutter filter(s) for D165538 marker here If left blank, the global stutter filt
é}--ﬁ)IdentiFiIerDirect_GSSDD_v1><
B---@IdentiFiIerDirect_GSSDD_F‘anE Minus Stutter Plus Stutter

0351179
Dz1511 Ratio From Distance Tao Distance Reatio From Diskance
D7s820 0942 325 4,75
CSFIPO
351358
THO1
0135317
165539

2

= w| ] =

E RS S

| mew |[ Edt |[ Delete |

®
(0]
>
[0
<
Q
©
e)
@
S
X
wn
o}
s
S
(0]

- [251338

FAnSATT

11. Click Apply, then OK to add the Identifiler'" Direct Kit panel, bin set, and marker
stutter to the GeneMapper " ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter will not be imported into the GeneMapper
ID-X Software database.

Create an analysis  Use the following procedure to create an analysis method for the Identifiler ™
method Direct Kit.

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created
for GeneMapper' " ID-X Software version 1.2 is not compatible with earlier versions
of GeneMapper'" ID-X Software, or with GeneMapper " ID Software version 3.2.1.

1. Select Tools » GeneMapper'" ID-X Manager to open the
GeneMapper " ID-X Manager.

« GeneMapper® ID-X Manager

Find Mame Caontaining:

Projecks | Analysis Methods | Table Settings || Flok Settings | Matrices | Size Standards | Report Settings

Mew. .. H Open. .. H Save As.., ][ Impart. .. H Export... [ Delete |

(e ] (Coe ] |
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2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.
3. Enter the settings shown in the figures on the following pages.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

4. After you enter the settings on all tabs, click Save.

General tab Analysis Method Editor ®

Settl n gs General | Allele | Peak Detector | Peak Quality || S0 & GG Settings

rAnalysis Method Description

Mame: |IdentiFiIerDirect_AnaIysisMethod_v1>< |

Security Group: |GeneMapper ID-% Security Group . |

Description:

A [ 3

Instrument:

Analysis Type: HID

[ Save H Cancel H Help ]

In the Name field, either type the name as shown or enter a name of your choosing. In
the Security Group field, select the Security Group appropriate to your software
configuration from the drop-down list. The Description and Instrument fields are

optional.
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Allele tab settings

| General| Allele: | Peak Detector || Peak Quality || S0 BGQ Settings|

Bin Set: |IdentiFiIerDirect_GSSDD_Bins_v1>< v |
[[] Use marker-specific stutter ratia and distance if available
Marker Repeat Type: Tri Tetra Penta Hexa
Global Cut-off Yalue 0.4 0.2 0.4 0.4
Minus& Ratio 0.0 0.0 0.0 0.0
Minus# Distance Fram 0.0 0.0 0.0 0.0
To (0.0 0.0 0.0 0.0
Global Minus Stutter Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From |00 3.25 0.0 0.0
To (0.0 4.75 0.0 0.0
Global Plus Stutter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Distance From 0.0 0.0 0.0 0.0
To (0.0 0.0 0.0 0.0
Amelogenin Cukoff

Range Filter... Factary Defaults

[ Save H Cancel H Help ]

* Inthe Bin Set field, select the IdentifilerDirect_GS500_Bins_v1X bin set imported
previously and configure the parameters as shown.

» GeneMapper " ID-X Software allows you to specify 4 types of marker repeat
motifs: tri, tetra, penta and hexa. You can enter parameter values for each type of
repeat in the appropriate column.

* Specify the stutter ratio:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the
IdentifilerDirect_GS500_Stutter_v1X.txt file, select the “Use marker-specific
stutter ratio if available” check box (selected by default). Perform
appropriate internal validation studies to determine the appropriate filter
setting to use.
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Pea!‘ Detector tab Analysis Method Editor ®
Sett in g S General | allsls | Peak Detector | peak Quality | 50 & GQ Settings

Peak Detection Algorithm: Advanced

Ranges Peak Detection Perform
AF”‘T:S:iS - SE:HSQ = Peak Amplitude Thresholds: internal
ull Range izes . . . .
I validation
| e[ ] studies to
v: o: determine
rSmoothing and Baselining———— Settings
Min, Peak Half width: |2 pts
Smoothing () Mone i
@ Light Palynomial Degree: 3
) Heavy Peak Window Size: 15 pts
Baseline Window: pts Sl iesiald
Peak Start: 0.0
rSize Calling Method Peak End: o0
(O 2nd Order Least Squares
(O 3rd Order Least Squares MermeliEstim
O Cubic Spline Interpalation Use Mormalization, if applicable
() Lacal Southern Method
(O Glabal Southern Methad

Factory Defaults

Save As H Save H Cancel H Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine
the appropriate peak amplitude thresholds for interpretation of Identifiler™
Direct Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper " ID-X Software displays peaks that fall below the specified
amplitude in electropherograms, the software does not label or determine the
genotype of these peaks.

* Size calling method — This kit has been validated using the Local Southern sizing
method. Before using alternative sizing methods, perform the appropriate
internal validation studies.

¢ Normalization (v1.2 or higher) — For use with 3500 data. Perform internal
validation studies to determine whether to use the Normalization feature for
analysis of Identifiler " Direct Kit data.
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Peak Quality tab Analysis Method Editor ®

settin gs | General || Allele | Peak Detector | Peak Quality | 5q & GQ Settings|

NIMax Peak Height (LPH{MPH)

Homozygous min peak height Perform
Heterozygous min peak height Interna.l
. validation

IMax Peak Height {MPH} studies to
determine

Peak Height Ratio {PHR) Settings

Qﬂ peak height: ratio
Broad Peak (BD)

Max peak width (basepairs)

2

Allele Mumber (AR)

Max expected alleles

®
(0]
>
[0
<
Q
©
e)
@
S
X
wn
o}
s
S
(0]

Allelic Ladder Spike

Spike Detection

MR N

Cut-off Yalue

Factory Defaults

Save As H Save H Cancel H Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds,
maximum peak height threshold, and the minimum peak height ratio threshold for

interpretation of Identifiler " Direct Kit data.
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SQ & GQ tab
settings

Create a size
standard

58

Analysis Method Editor.

General | Allels || Peak Detector | Peak Quality | 50 & GQ Settings |

Quality weights are between 0 and 1.

%

Genotype Quality:  From to 1.0 FromO.0ko |0.25

rSample and Control GG Weighting
Broad Peak (BD) Allele Mumber (AR)
Out of Bin Allels (BIN) Low Peak Haight (LPH)
Overlap (OYL) Max Peak Height (MPH)
Marker Spike (SPK) Off-scals (05)
Peak Height Ratio (PHR)
Control Concordance {CC) Weight = 1.0 {Only applicable to controls)
S0 Weighting
Broad Peak (BD)
rallelic Ladder Go Weighting
Spike (SSPK/SPK) Off-scale (05)
50 & G0 Ranges
Sizing Quality: Fram to 1.0 FromO.0ko |0.25

Reset Defaults

Save As H Save H Cancel H Help ]

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to

determine the appropriate values to use.

The size standards for the Identifiler " Direct Kit uses the following size

standard peaks in their definitions:

GeneScan™ 500 LIZ™ Size Standard
peak sizes

GeneScan™ 600 LIZ™ Size Standard
v2.0 peak sizes

75,100, 139, 150, 160, 200, 300, 350, 400, and
450

80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
240, 250, 260, 280, 300, 314, 320, 340, 360,
380, 400, 414, 420, 440 and 460

Note: The 250-nt and the 340-nt peaks in the GeneScan"" 500 LIZ"" Size Standard are
not included in the size standard definition. These peaks can be used as an indicator of

precision within a run.

Use the following procedure to create the size standard for the Identifiler" Direct Kit.

1. Select Tools » GeneMapper™" ID-X Manager to open the GeneMapper'" ID-X

Manager.
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2. Select the Size Standards tab, then click New.

Find Mame Containing: ‘|

| Prajects | Analysis Methods || Table Settings | Plat Settings | Matrices| Size Standards | Repart Settings |

Marme Last Saved Chner Type Descripkion
| CE_F_HID_G5500 (75-400) 2007-05-09 13:23:5 | gmids Advanced -~
| CE_F_HID_GS500 (75-450) 2007-05-09 13:24:0 | gmidx Advanced b
| CE_G5_HID_GS500 2011-04-15 13:15:¢ | grid Advanced =
Mew, ., Open... Save As... Expork. .. Delete )

3. Complete the Name field as shown below or with a name of your choosing. In the
Security Group field, select the Security Group appropriate to your software
configuration from the drop-down list. In the Size Standard Dye field, select
Orange. In the Size Standard Table, enter the peak sizes specified on page 58. The
example below is for the GeneScan™ 500 LIZ"™ Size Standard.

* Size Standard) Editor, 3]

®
D
>
[0
<
Q
©
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@
S
X
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s
S
(0]

Edit
rSize Standard Description
Name; CE_a5_IdentifilerDirect_55500
Security Group: GeneMapper [D-X Security Group | %
Description:
Size Standard Drye:
rSize Standard Table
: j:;in Basepairs ] [ Insert ] [ Delete l
z (1000
3 (139.0
4 (150.0 -
5 (1600
6 |200.0
7 |300.0
& (350.0
9 [400.0
.
. ~
[ QK l [ Cancel l [ Help l
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Analyze and edit sample files with GeneMapper™ ID-X Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above. If you named the settings
differently, select the names you specified.

Parameter Settings

Sample Type Select the sample type.

Analysis Method | IdentifilerDirect_AnalysisMethod_v1X (or the name of the analysis
method you created)

Panel IdentifilerDirect_GS500_Panels_v1X

Size Standard CE_G5_IdentifilerDirect_GS500 (or the name of the size standard
you created)

For more information about how the Size Caller works, or about size standards,
refer to the GeneMapper'™ ID-X Software v1.2 Reference Guide (Part no. 4426481).

3. Click I* (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis. During a run:

e The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage completed indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Analysis Summary tab is displayed upon completion of the analysis.

The figure below shows the analysis summary window after analysis.

+ GeneMapper® ID-X - Identifiler Direct Example - gmidx Is Logged In Database GBOLDROYNJO9E DE®
File Edt Analysis Yiew Tools Admin  Help
== = =) it b @ | Table Setiing: ‘EIXXDataAna\ysls v|ﬁ S &SRk De
= a2y Project Samples | Analysis Summary | Genatypes
I3 Identifiler Direct Example Q ‘ =
Analysis Summary Surm
Select run folder to display:
Sample Status [ Total # of Samples ]
[ Unanalyzed 0 |
Analyzad 8 |
U Analysis Setting Changed ] |

Click a link below to display a filtered Samples Table containing only the samples selected.
Allelic Ladder Quality per run folder (hased on SQ and CGQ only)

Run Folder J( Totel # cf Anslyzed Ladders | & [ & )
| 2 |

Tdentifiler Dirack Example Data | z

Control Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, SQ, CGQ)

Control Type: [ Total # of Samples [ Allthresholds met [ @ Orne or more thresholds not met
0 0

Fositive Control
Custom Contral
Negative Control
Total

0 0
0 0
0 0

olo|ala

Sample Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, SQ, CGQ)

I J[Total # of Samples I Al thresholds met [ @ Orne or more thresholds not met |
Samples | 5 | 0 | 6 | -

Pl Sl | 3

nalysis Complated. | Stop
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Examine and edit a project

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).

For more information

For more information about any of these tasks, refer to:
» GeneMapper"' ID-X Software Version 1.0 Getting Started Guide (Part no. 4375574)

o GeneMapper™ ID-X Software Version 1.0 Quick Reference Guide (Part no.
4375670)

» GeneMapper" ID-X Software Version 1.0 Reference Guide (Part no. 4375671)

o GeneMapper™ ID-X Software Version 1.1(Mixture Analysis) Getting Started Guide
(Part no. 4396773)

o GeneMapper™ ID-X Software Version 1.2 Reference Guide (Part no. 4426481)

* GeneMapper"' ID-X Software Version 1.2 Quick Reference Guide (Part no.
4426482)
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For more information
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This chapter provides results of the developmental validation experiments we
performed using the Identifiler"" Direct Kit for samples punched from FTA™ cards.

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics. By
challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations
which are critical for sound data interpretation in casework (Sparkes, Kimpton,
Watson et al., 1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin et al., 1998).

We performed experiments to evaluate the performance of the Identifiler™" Direct Kit.
according to the DNA Advisory Board (DAB) Quality Assurance Standards, effective
October 1, 1998 (DNA Advisory Board, 1998). The DAB standards describe the quality
assurance requirements that a laboratory should follow to ensure the quality and
integrity of the data and competency of the laboratory.

Additional validation was performed according to the revised guidelines from the
Scientific Working Group on DNA Analysis Methods (SWGDAM, July 10, 2003). Based
on these guidelines, we conducted experiments that comply with guidelines 1.0 and
2.0 and its associated subsections. This DNA methodology is not novel. (Moretti ef al.,
2001; Frank et al., 2001; Wallin et al., 2002; and Holt et al., 2000).
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Accuracy, precision, and reproducibility

This chapter discusses many of the experiments we performed and provides examples
of results obtained. We chose conditions that produced optimum PCR product yield
and that met reproducible performance standards. It is our opinion that while these
experiments are not exhaustive, they are appropriate for a manufacturer of STR kits
intended for forensic and/or parentage testing use. Each laboratory using the
Identifiler' Direct Kit should perform their own internal validation studies.

Validation studies included testing on the following sample+substrate combinations:

» Unpurified, single-source blood or buccal samples on FTA™ paper (treated
paper substrate)

* Buccal samples on a Bode Buccal DNA Collector™ (untreated paper substrate)

Additional performance verification studies included testing on Copan
4N6FLOQSwabs™ (swab substrate).

We did not perform mixture or inhibition studies during the developmental

validation of the Identifiler’™ Direct Kit because these tests are not relevant for the
intended use of this chemistry.

Accuracy, precision, and reproducibility

SWGDAM guideline
1.2.1

SWGDAM guideline
2.9

Accuracy

64

“Developmental validation is the demonstration of the accuracy, precision, and
reproducibility of a procedure by the manufacturer, technical organization, academic
institution, government laboratory, or other party.” (SWGDAM, July 2003)

“The extent to which a given set of measurements of the same sample agree with their
mean and the extent to which these measurements match the actual values being
measured should be determined.” (SWGDAM, July 2003)

Laser-induced fluorescence detection of length polymorphism at short tandem repeat
loci is not a novel methodology (Holt et al., 2000; and Wallin et al., 2002). However,
accuracy and reproducibility of Identifiler'" Direct Kit profiles have been determined
from various sample types. Figure 3 illustrates the size differences that are typically
observed between sample alleles and allelic ladder alleles on the Applied
Biosystems'" 3130x/ Genetic Analyzer with POP-4~ polymer. The x-axis in Figure 3
represents the nominal nucleotide sizes for the AmpF(STR™ Identifiler' " Direct
Allelic Ladder. The dashed lines parallel to the x-axis represent +0.25-nt windows.
The y-axis represents the deviation of each sample allele size from the corresponding
allelic ladder allele size. All sample alleles are within +0.5 nt from a corresponding
allele in the allelic ladder.
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Accuracy, precision, and reproducibility

Figure 3 Size deviation of 200 blood samples on FTA™ card analyzed on
the Applied Biosystems 3130x({ Genetic Analyzer
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Sizing precision allows for determining accurate and reliable genotypes. Sizing
precision was measured on the Applied Biosystems" 3130x/ Genetic Analyzer. The
recommended method for genotyping is to employ a +0.5-nt “window” around the
size obtained for each allele in the AmpF(STR " Identifiler" Direct Allelic Ladder. A
+0.5-nt window allows for the detection and correct assignment of alleles. Any sample
allele that sizes outside the specified window could be:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the
AmpF(STR™ Identifiler™ Direct Allelic Ladder
or

* An allele that corresponds to an allelic ladder allele, but whose size falls just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections on a capillary instrument.

Table 3 on page 66 shows typical precision results obtained from five runs

(16 capillaries/run) of the AmpF(STR™ Identifiler'" Direct Allelic Ladder on the
Applied Biosystems"" 3130x! Genetic Analyzer (36-cm capillary and POP-4"™
polymer) sized using the GeneScan'" 500 LIZ™ Size Standard. The results were
obtained within a consecutive set of injections on a single capillary array.

Sample alleles may occasionally size outside of the +0.5-nt window for a respective
allelic ladder allele because of measurement error. The frequency of such an
occurrence is lowest in detection systems having the smallest standard deviations in
sizing. Figure 3 illustrates the tight clustering of allele sizes obtained on the Applied
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Biosystems'" 3130x/ Genetic Analyzer, where the standard deviation in sizing is
typically less than 0.15 nt. The instance of a sample allele sizing outside the +0.5-nt
window because of measurement error is relatively rare when the standard deviation
in sizing is approximately 0.15 nt or less (Smith, 1995).

For sample alleles that do not size within a +0.5-nt window, the PCR product must be
rerun to distinguish between a true off-ladder allele versus measurement error of a
sample allele that corresponds with an allele in the allelic ladder. Repeat analysis,
when necessary, provides an added level of confidence to the final allele assignment.

GeneMapper'" ID Software and GeneMapper' ID-X Software automatically flag
sample alleles that do not size within the prescribed window around an allelic ladder
allele by labelling the allele as OL (Off-ladder).

Maximum precision is obtained with a set of capillary injections on each of the
supported platforms however the determined allele sizes will vary between the
different platforms. Cross-platform sizing differences occur from a number of factors
including type and concentration of polymer, run temperature, and electrophoresis
conditions. Variations in sizing can also occur between runs on the same instrument
and between runs on different instruments of the same platform type because of these
factors.

We recommend strongly that the allele sizes obtained should be compared to the
sizes obtained for known alleles in the AmpF(STR™ Identifiler Direct Allelic Ladder
from the same run and then converted to genotypes (as described in “Before you
start” on page 35 and 48). Refer to Table 3 for the results of five runs of the
AmpF(STR™ Identifiler'™ Direct Allelic Ladder. For more information on precision
and genotyping, see Lazaruk et al., 1998 and Mansfield ef al., 1998.

In Table 3, the mean sizes for all the alleles in each run (16 capillaries) were calculated.
The mean range shown in the table represents the lowest- and highest-mean size
values obtained across all five runs. Similarly, the standard deviation for the allele
sizing was calculated for all the alleles in each run. The standard deviation range
shown in Table 3 represents the lowest and highest standard deviation values obtained
across all five runs.

Table3 Precision results of five runs (16 capillaries/run) of the AmpF(STR™ Identifiler™ Direct
Allelic Ladder

Applied Biosystems™ 3130x! Genetic Analyzer

Allele Mean Standard deviation

Amelogenin

X 106.26-106.43 0.033-0.044

Y 111.92-112.06 0.032-0.046
CSF1PO

6 304.04-304.20 0.038-0.053

7 308.09-308.26 0.033-0.052

8 312.15-312.32 0.038-0.047

9 316.20-316.37 0.033-0.048

10 320.24-320.42 0.027-0.051

" 324.30-324.45 0.033-0.055
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Applied Biosystems™ 3130x( Genetic Analyzer

Allele Mean Standard deviation
12 328.34-328.49 0.036-0.053
13 332.37-332.52 0.033-0.047
14 336.42-336.57 0.038-0.052
15 340.46-340.60 0.036-0.045

D13S317
8 216.56-216.75 0.033-0.050
9 220.55-220.72 0.020-0.051
10 224.53-224.70 0.035-0.043
" 228.52-228.70 0.037-0.048
12 232.58-232.76 0.037-0.049
13 236.48-236.66 0.031-0.051
14 240.40-240.60 0.037-0.044
15 244.40-244.59 0.038-0.048
D16S539
5 252.22-252.42 0.040-0.050
8 264.17-264.35 0.030-0.052
9 268.18-268.35 0.040-0.051
10 272.15-272.33 0.031-0.048
" 276.16-276.33 0.034-0.047
12 280.15-280.34 0.039-0.050
13 284.16-284.33 0.032-0.052
14 288.17-288.33 0.029-0.058
15 292.17-292.36 0.037-0.055
D18S51
7 261.88-261.98 0.028-0.045
9 269.99-270.12 0.039-0.058
10 274.08-274.20 0.031-0.045
10.2 276.08-276.20 0.029-0.054
" 278.15-278.28 0.040-0.047
12 282.22-282.35 0.036-0.049
13 286.27-286.40 0.038-0.053
13.2 288.28-288.42 0.040-0.050
14 290.37-290.50 0.033-0.049
14.2 292.39-292.50 0.037-0.053
15 294.47-294.60 0.038-0.050
16 298.55-298.70 0.041-0.053
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Applied Biosystems™ 3130x( Genetic Analyzer

Allele Mean Standard deviation
17 302.68-302.82 0.034-0.052
18 306.82-306.99 0.042-0.053
19 310.96-311.11 0.043-0.060
20 315.10-315.25 0.031-0.048
21 319.23-319.38 0.031-0.049
22 323.42-323.57 0.038-0.054
23 327.48-327.63 0.043-0.055
24 331.59-331.74 0.031-0.052
25 335.69-335.83 0.029-0.052
26 339.81-339.96 0.044-0.052
27 343.92-344.04 0.037-0.051

D19S433
9 101.38-101.46 0.032-0.039
10 105.28-105.36 0.030-0.036
" 109.20-109.28 0.027-0.042
12 113.14-113.22 0.028-0.038
12.2 115.15-115.21 0.032-0.038
13 17.11-117.17 0.030-0.045
13.2 119.11-119.17 0.028-0.038
14 121.07-121.14 0.022-0.045
14.2 123.10-123.17 0.035-0.047
15 125.09-125.13 0.031-0.048
15.2 127.12-127.16 0.026-0.045
16 129.11-129.16 0.034-0.044
16.2 131.17-131.20 0.028-0.044
17 133.17-133.22 0.033-0.044
17.2 135.24-135.27 0.022-0.043
D21S11
24 184.40-184.51 0.035-0.042
24.2 186.39-186.50 0.023-0.043
25 188.35-188.44 0.025-0.040
26 192.30-192.39 0.029-0.043
27 196.27-196.33 0.026-0.042
28 200.14-200.21 0.039-0.043
28.2 202.11-202.18 0.028-0.042
29 204.08-204.16 0.031-0.041
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Applied Biosystems™ 3130x( Genetic Analyzer

Allele Mean Standard deviation
29.2 206.14-206.21 0.031-0.041
30 208.10-208.17 0.024-0.039
30.2 210.08-210.15 0.019-0.040
31 212.09-212.16 0.028-0.036
31.2 214.06-214.13 0.025-0.041
32 216.07-216.15 0.032-0.045
32.2 218.04-218.12 0.030-0.038
33 220.06-220.14 0.022-0.042
33.2 222.01-222.07 0.029-0.045
34 224.13-224.21 0.020-0.041
34.2 226.02-226.11 0.030-0.042
35 228.10-228.18 0.027-0.047
35.2 230.02-230.10 0.036-0.052
36 232.01-232.10 0.032-0.046
37 236.07-236.15 0.030-0.040
38 240.00-240.09 0.036-0.045

D2S51338
15 306.40-306.56 0.032-0.056
16 310.49-310.64 0.036-0.049
17 314.56-314.72 0.034-0.048
18 318.62-318.77 0.038-0.040
19 322.69-322.84 0.025-0.044
20 326.74-326.89 0.035-0.049
21 330.81-330.95 0.030-0.042
22 334.87-335.00 0.029-0.047
23 338.90-339.05 0.039-0.052
24 342.94-343.08 0.039-0.047
25 346.99-347.13 0.031-0.050
26 350.99-351.13 0.040-0.051
27 354.94-355.06 0.031-0.050
28 359.08-359.21 0.031-0.054
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Applied Biosystems™ 3130x( Genetic Analyzer

Allele Mean Standard deviation
D351358
12 111.35-111.49 0.034-0.052
13 115.45-115.58 0.034-0.046
14 119.44-119.58 0.034-0.047
15 123.37-123.49 0.035-0.053
16 127.55-127.67 0.033-0.051
17 131.74-131.86 0.029-0.048
18 135.85-135.96 0.035-0.050
19 139.96-140.07 0.036-0.056
D55818
7 133.85-133.95 0.037-0.048
8 137.96-138.06 0.040-0.046
9 142.31-142.42 0.032-0.045
10 146.78-146.89 0.033-0.044
1" 151.13-151.26 0.032-0.043
12 155.36-155.50 0.027-0.042
13 159.51-159.67 0.020-0.045
14 163.57-163.73 0.032-0.044
15 167.60-167.76 0.030-0.055
16 171.63-171.77 0.036-0.049
D75820
6 255.09-255.23 0.031-0.047
7 259.11-259.25 0.038-0.048
8 263.13-263.27 0.036-0.049
9 267.16-267.29 0.029-0.041
10 271.20-271.32 0.041-0.048
" 275.23-275.37 0.032-0.051
12 279.26-279.40 0.037-0.047
13 283.28-283.43 0.035-0.049
14 287.32-287.45 0.043-0.052
15 291.35-291.49 0.037-0.053
D8S1179
8 122.84-122.95 0.030-0.046
9 126.91-127.01 0.027-0.053
10 131.01-131.10 0.031-0.052
" 135.14-135.24 0.037-0.051
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Applied Biosystems™ 3130x( Genetic Analyzer

Allele Mean Standard deviation
12 139.33-139.43 0.029-0.059
13 143.90-144.02 0.027-0.045
14 148.36-148.48 0.034-0.045
15 152.70-152.82 0.022-0.044
16 156.93-157.09 0.026-0.041
17 161.08-161.24 0.026-0.046
18 165.14-165.33 0.035-0.056
19 169.22-169.40 0.035-0.056

FGA
17 214.31-214.49 0.035-0.046
18 218.33-218.5 0.037-0.046
19 222.38-222.56 0.020-0.047
20 226.40-226.58 0.036-0.046
21 230.42-230.60 0.032-0.046
22 234.46-234.65 0.033-0.047
23 238.49-238.69 0.038-0.048
24 242.54-242.73 0.038-0.054
25 246.57-246.78 0.033-0.050
26 250.62-250.82 0.039-0.059
26.2 252.63-252.82 0.040-0.045
27 254.63-254.82 0.035-0.053
28 258.69-258.89 0.038-0.051
29 262.75-262.95 0.045-0.053
30 266.81-267.04 0.033-0.054
30.2 268.66-268.85 0.042-0.062
31.2 272.72-272.93 0.039-0.052
32.2 276.78-277.01 0.037-0.055
33.2 280.85-281.07 0.044-0.053
42.2 317.96-318.20 0.042-0.057
43.2 322.08-322.31 0.051-0.056
442 326.18-326.43 0.039-0.059
452 330.33-330.55 0.046-0.060
46.2 334.34-334.56 0.039-0.047
47.2 338.43-338.65 0.047-0.056
48.2 342.59-342.80 0.047-0.064
50.2 350.71-350.91 0.040-0.053
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Applied Biosystems™ 3130x( Genetic Analyzer

Allele Mean Standard deviation
51.2 354.67-354.87 0.048-0.058
THO1
4 162.79-162.92 0.034-0.054
5 166.84-166.97 0.034-0.048
6 170.88-171.00 0.030-0.047
7 174.88-175.01 0.028-0.046
8 178.89-179.01 0.031-0.045
9 182.87-182.98 0.031-0.042
9.3 185.90-186.02 0.025-0.049
10 186.83-186.94 0.035-0.047
1" 190.79-190.89 0.025-0.046
12 201.62-201.71 0.034-0.045
TPOX
6 221.96-222.07 0.030-0.043
7 225.93-226.04 0.035-0.044
8 229.90-230.01 0.027-0.043
9 233.86-233.98 0.032-0.03¢9
10 237.86-237.98 0.023-0.049
1" 241.83-241.96 0.028-0.037
12 245.84-245.95 0.032-0.043
13 249.83-249.93 0.027-0.044
VWA
1" 154.16-154.27 0.025-0.044
12 158.30-158.44 0.029-0.054
13 162.40-162.54 0.034-0.045
14 166.62-166.78 0.029-0.048
15 170.56-170.70 0.028-0.046
16 174.57-174.71 0.028-0.045
17 178.56-178.71 0.028-0.045
18 182.51-182.66 0.032-0.044
19 186.48-186.60 0.031-0.045
20 190.41-190.53 0.026-0.043
21 194.29-194.43 0.032-0.044
22 198.21-198.33 0.025-0.043
23 202.06-202.18 0.034-0.040
24 206.38-206.48 0.031-0.040

72 AmpFISTR™ Identifiler™ Direct PCR Amplification Kit User Guide



Chapter 5 Experiments and Results

Extra peaks in the electropherogram

Extra peaks in the electropherogram

Causes of extra
peaks

Stutter products

Peaks other than the target alleles may be detected on the electropherogram. Causes
for the appearance of extra peaks include stutter products, incomplete 3" A nucleotide
addition (at the n-1 position), dye artifacts, and mixed DNA samples (see DAB
Standard 8.1.2.2).

A stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller (or less frequently, one repeat larger) than the major STR
product (Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter products at
tetranucleotide STR loci has revealed that the stutter product is missing a single
tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996).

The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Peak heights were measured for amplified samples at the loci used in the
Identifiler" Direct Kit:

 Treated paper workflow: 370 blood samples on FTA™ card and 299 buccal
samples on Indicating FTA™ cards

¢ Untreated paper workflow: 370 buccal samples on Bode Buccal DNA Collectors
All data were generated on the Applied Biosystems 3130xI Genetic Analyzer.
Some conclusions from these measurements and observations are:

* For each Identifiler'" Direct Kit locus, the percent stutter generally increases with
allele length, as shown in

— Treated paper workflow: Figure 4 through Figure 7 on page 74
through page 75
— Untreated paper workflow: Figure 8 through Figure 11 on page 76 through
page 77
* Smaller alleles display a lower level of stutter relative to the longer alleles within
each locus.

* Each allele within a locus displays a percent stutter that is consistent.

* The stutter value for each locus shown for the treated paper workflow in Table 4
on page 78 was determined by taking the mean plus three times the standard
deviation. These values are the stutter filter percentages in the Identifiler"" Direct
stutter file and will be used during the filtering step in GeneMapper " ID Software
or GeneMapper'" ID-X Software. Peaks in the stutter position that are above the
stutter filter percentage will not be filtered. Peaks in the stutter position that have
not been filtered and remain labeled can be further evaluated.

¢ Stutter percentages generated using the untreated paper workflow were
calculated on a different, smaller data set than was used for the original stutter
calculations. We used the stutter values of the most common alleles at each locus
to compare the data sets. There was no significant difference in the stutter values
(mean plus three times the standard deviation) for the individual loci with the
exception of D351358 (0.7%), D75820 (0.4%), D165539 (0.2%) and FGA (1.2%). For
D351358, D75820, and FGA, the stutter values were slightly lower than the
original stutter values calculated for punches from FTA™ cards processed with the
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Identifiler Direct Kit. The D16S539 stutter percentage (mean plus three times
the standard deviation) was slightly higher than the original stutter value. You
should evaluate the impact of sample type on stutter percentages when
implementing a direct amplification system.

* The measurement of percent stutter for allele peaks that are off-scale may be
unusually high. Off-scale peaks were not included in the evaluation of stutter
characterized here.

Figure 4 Treated paper workflow: FTA™ card sample stutter percentages for D8S1179,
D21S11, D7S820, and CSF1PO loci (red = blood samples; blue = buccal samples)
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Figure5 Treated paper workflow: FTA™ card sample stutter percentages for D351358,
THO1, D135317, D165539, and D251338 loci (red = blood samples; blue = buccal samples)
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Figure 6 Treated paper workflow: FTA™ card sample stutter percentages for D195433,

VWA, TPOX, and D18551 loci (red = blood samples; blue = buccal samples)
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Figure 7 Treated paper workflow: FTA™ card sample stutter percentages for D55818 and
FGA loci (red = blood samples; blue

= buccal samples)
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Figure 8 Untreated paper workflow: Bode Buccal DNA Collector™ sample stutter percentages
for D851179, D21511, D75820, and CSF1PO loci
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Figure 9 Untreated paper workflow: Bode Buccal DNA Collector™ sample stutter percentages
for D351358, THO1, D13S317, D165539, and D251338 loci
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Figure 10 Untreated paper workflow: Bode Buccal DNA Collector™ sample stutter percentages
for D19S433, VWA, TPOX, and D18S51 loci
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Figure 11 Untreated paper workflow: Bode Buccal DNA Collector™ sample stutter percentages
for D55818 and FGA loci (red = blood samples; blue = buccal samples)
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Table4 Treated paper workflow: FTA™ card sample marker-specific stutter filter percentages
for Identifiler™ Direct Kit loci

Locus % Stutter®
CSF1PO 8.48
D13S317 9.39
D165539 9.42
D18S51 12.89
D19S433 11.15
D21S11 10.42
D251338 11.77
D351358 11.45
D55818 9.89
D75820 8.60
D8S1179 9.54

FGA 11.62
THO1 4.76
TPOX 5.27
vWA 11.99

t+ These percentages are used as stutter filters in GeneMapper™ /D Software
IdentifilerDirect_GS500_Panels_v1 and GeneMapper™ ID-X Software
|dentifilerDirect_GS500_Stutter_v1X.txt.

AmpliTaq Gold™ enzyme, like many other DNA polymerases, can catalyze the
addition of a single nucleotide (predominately adenosine) to the 3" ends of double-

stranded PCR products (Clark, 1988; Magnuson et al., 1996). This nontemplate addition
results in a PCR product that is one nucleotide longer than the actual target sequence.
The PCR product with the extra nucleotide is referred to as the “+A” form.

The efficiency of +A addition is related to the particular sequence of the DNA at the 3

" end of the PCR product. The AmpF(STR ™" Identifiler™ Direct PCR Amplification Kit
includes two main design features that promote maximum +A addition:

¢ The primer sequences have been optimized to encourage +A addition.

¢ The final extension step is 60°C for 25 min.

The final extension step gives the AmpliTaq Gold™ DNA polymerase additional
time to complete +A addition to all double-stranded PCR products. STR systems
(where each allele is represented by two peaks that are one nucleotide apart) that
have not been optimized for +A addition may have “split peaks.”
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Characterization of loci

Figure 12 Omitting the final extension step results in split peaks due to incomplete A nucleotide addition. Data are from
an Applied Biosystems 3130x{ Genetic Analyzer using the AmpF(STR™ Identifiler™ Direct Kit.
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Artifacts

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible while anomalies are non-reproducible, intermittent occurrences
that are not observed consistently in a system (for example, spikes and baseline noise).
Reproducible artifacts have not been seen in data produced on the genetic analyzers
used during developmental validation of the Identifiler" Direct Kit.

Characterization of loci

SWGDAM guideline
2.1

Nature of the
polymorphisms

“The basic characteristics of a genetic marker must be determined and documented.”
(SWGDAM,, July 2003)

This section describes basic characteristics of the 15 loci and the sex-determining

marker, Amelogenin that are amplified with the Identifiler ™ Direct Kit. These loci
have been extensively characterized by other laboratories.

The primers for the Amelogenin locus flank a 6-nucleotide deletion within intron 1 of
the X homologue. Amplification results in 107-nt and 113-nt products from the X and Y
chromosomes, respectively. (Sizes are the actual nucleotide size according to
sequencing results, including 3 A nucleotide addition.) The remaining Identifiler™
Direct Kit loci are all tetranucleotide short tandem repeat (STR) loci. The length
differences among alleles of a particular locus result from differences in the number of
4-nt repeat units.
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We have subjected to sequencing all the alleles in the AmpF(STR™ Identifiler™
Direct Allelic Ladder. In addition, other groups in the scientific community have
sequenced alleles at some of these loci. Among the various sources of sequence data

on the Identifiler " Direct Kit loci, there is consensus on the repeat patterns and

structure of the STRs.

The Identifiler" Direct Kit loci have been mapped, and the chromosomal locations
have been published (Nakahori ef al., 1991; Edwards et al., 1992; Kimpton et al., 1992;
Mills et al., 1992; Sharma and Litt, 1992; Li et al., 1993; Straub et al., 1993; Barber and
Parkin, 1996).

Species specificity

SWGDAM Guideline

2.2

“For techniques designed to type human DNA, the potential to detect DNA from
forensically relevant nonhuman species should be evaluated.” (SWGDAM, July 2003)

The Identifiler"" Direct Kit provides the required specificity for detecting primate
alleles. Other species do not amplify for the loci tested.

Nonhuman studies

Nonhuman DNA may be present in forensic casework samples. The data from
Identifiler " Direct Kit experiments on nonhuman DNA sources are shown in Figure

13.

Figure 13 Representative electropherograms from a species-specificity study including positive and non-template controls
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SWGDAM guideline
2.3

Blood on FTA™
cards

Buccal cells on
FTA™ or Indicating
FTA™ cards and
buccal cells on
Bode DNA
Collectors

Chapter 5 Experiments and Results
Sensitivity

Figure 13 shows amplification for: Control DNA 9947A (1 ng, panel 1), chimpanzee

(1 ng, panel 2), pig (10 ng, panel 3), cat (10 ng, panel 4), microbial DNA pool
(equivalent to 105 copies of Candida albicans, Enterococcus faecalis, Escherichia coli,
Fusobacterium nucleatum, Lactobacillus casei, Staphylococcus aureus, Streptococcus mitis,
Streptococcus mutans, Streptococcus salivarius, and Streptococcus viridans, panel 5), and the
non-template control (panel 6). The extracted DNA samples were amplified with the
Identifiler Direct Kit and analyzed using the Applied Biosystems 3130x! Genetic
Analyzer.

* Primates: gorilla, chimpanzee, orangutan, and macaque (1 ng each)

* Non-primates: mouse, dog, pig, cat, horse, hamster, rat, chicken, and cow (10 ng
each)

* Microorganisms: Candida albicans, Enterococcus faecalis, Escherichia coli,
Fusobacterium nucleatum, Lactobacillus casei, Staphylococcus aureus, Streptococcus
mitis, Streptococcus mutans, Streptococcus salivarius, and Streptococcus viridans
(equivalent to 105 copies). These microorganisms are commonly found in the oral
cavity (Suido ef al., 1986; Guthmiller et al., 2001).

All the primate DNA samples amplified, producing fragments within the 100 to
350 base pair region (Lazaruk, et al., 2001; Wallin, et al., 1998).

The microorganisms, chicken, cat, hamster, rat, rabbit, and mouse samples did not
yield detectable product. Horse, cow, dog, and pig samples produced a 104-bp
fragment near the Amelogenin locus in PET™ dye.

“When appropriate, the range of DNA quantities able to produce reliable typing
results should be determined.” (SWGDAM, July 2003)

The Identifiler™ Direct Kit has been optimized at 25 uL PCR reaction volume to
overcome the PCR inhibition expected when amplifying blood samples directly from
unpurified 1.2 mm FTA™ discs. Depending on the volume of blood spotted onto the
FTA™ card, DNA quantities present on the 1.2 mm disc may vary from laboratory to
laboratory. It is essential for your laboratory to optimize the PCR conditions based on
the types of blood samples received or based on your standard operating protocol
used in the spotting of blood onto FTA™ cards. Refer to page 17 for instructions on
PCR optimization.

The Identifiler™ Direct Kit has been optimized at 25 uL PCR reaction volume to
overcome the PCR inhibition expected when amplifying buccal cells directly from
unpurified 1.2 mm FTA™ discs or Indicating FTA™ discs. Depending on the
collecting devices used, the collection methods applied, and the swab-to-FTA™
transfer protocol employed, DNA quantities present on the 1.2 mm disc may vary
from sample to sample and from laboratory to laboratory. It is essential for your
laboratory to optimize the PCR conditions based on the types of buccal samples
received or based on your standard operating protocol used in transferring saliva
from a buccal swab onto an FTA™ card or Indicating FTA™ cards. Refer to page 17
for instructions on PCR optimization.
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Sensitivity

Effect of DNA If too much DNA is added to the PCR reaction, the increased amount of PCR product
quantity on results that is generated can result in:
¢ Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data).
Off-scale data is a problem because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy
results in poor spectral separation (“pull-up”).
¢ Incomplete +A nucleotide addition.
To ensure minimal occurrence of offscale data when using the Identifiler'" Direct
Kit, optimize PCR cycle number according to instructions on page 17.

When the total number of allele copies added to the PCR is extremely low, unbalanced
amplification of the alleles may occur because of stochastic fluctuation.

Individual laboratories may find it useful to determine an appropriate minimum peak
height threshold based on their own results and instruments using low amounts of
input DNA.
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Figure 14 Effect of amplifying varying amounts of white blood cells (WBCs) spotted onto Indicating FTA™ discs
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SWGDAM guideline

2.4

Note that the y-axis scale is magnified for the lower amounts of DNA, analyzed using
the Applied Biosystems™ 3130x! Genetic Analyzer. The amount of DNA on the
Indicating FTA™ cards were calculated based on the assumptions of 100% cell lysis
efficiency and that each cell contain 6 pg of DNA.

The results from white blood cells spotted onto Bode DNA Collectors were
comparable to the results shown here obtained using the Identifiler' " Direct Kit with
white blood cells spotted onto FTA™ Indicating Cards (data not shown).

“The ability to obtain results from DNA recovered from biological samples deposited
on various substrates and subjected to various environmental and chemical insults has
been extensively documented. In most instances, assessment of the effects of these
factors on new forensic DNA procedures is not required. However, if substrates and/or
environmental and/or chemical insults could potentially affect the analytical process,
then the process should be evaluated using known samples to determine the effects of
such factors.” (SWGDAM, July 2003)
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Stability

Aged blood on FTA™ cards and aged buccal cells on Indicating FTA™ cards were
prepared to examine the sample-on-substrate stability. Finger-prick blood spotted
onto FTA™ card and buccal samples swabbed and transferred using the EasiCollect"™
devices were collected on three individuals over the course of 30 weeks. The
Identifiler'™ Direct Kit was used to amplify the aged FTA™ samples in a GeneAmp""
PCR System 9700 with the gold-plated silver 96-well block and were electrophoresed
and detected using an Applied Biosystems'" 3130x! Genetic Analyzer. The results of
the aged blood on FTA™ card are shown in Figure 15 and the results of the aged
buccal cells on Indicating FTA™ card are shown in Figure 16. The analysis revealed
that the age of the FTA™ samples did not impact the performance of the AmpF(STR
Identifiler ™ Direct Kit.

™

Figure 15 Amplification of blood on FTA™ card stored for various amounts of time at room temperature
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Figure 16 Amplification of buccal cells on Indicating FTA™ card stored for various amounts of time at room temperature
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DNA on buccal Aged buccal cell samples on Copan 4N6FLOQSwabs™, Whatman'" OmniSwabs, and

swabs Puritan swabs were also prepared to verify their respective sample-on-substrate
stability. Buccal swabs were collected from 40 individuals on each swab type over the
course of three months. The aged swab samples were processed with Prep-n-Go™"
Buffer, amplified using the Identifiler"" Direct Kit in a GeneAmp"" PCR System 9700
with the gold-plated silver 96-well block, and were electrophoresed and detected

using an Applied Biosystems'" 3130x/ Genetic Analyzer. Figure 17 shows the results
of the aged buccal samples collected on each swab type and lysed at 90°C for 20
minutes. For comparison, Figure 18 shows the results of fresh buccal samples
collected on Copan 4N6FLOQSwabs™ and lysed at room temperature.

The analysis revealed that buccal samples on the swab types tested, air-dried
immediately after collection, and aged up to three months at room temperature
produce acceptable profiles when amplified with the Identifiler" Direct Kit.

Figure 17 Amplification of buccal cells on aged Copan 4N6FLOQSwabs™, OmniSwabs, and Puritan swabs stored for 3 months
at room temperature and lysed with Prep-n-Go™ Buffer at 99°C for 20 minutes
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Figure 18 Amplification of buccal cells on fresh Copan 4N6FLOQSwabs™ and lysed with Prep-n-Go™ Buffer at room
temperature
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Population data

SWGDAM guideline
2.7

Overview

Population
samples used in
these studies

Identifiler™
Direct Kit allele
frequencies
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“The distribution of genetic markers in populations should be determined in relevant
population groups.” (SWGDAM, July 2003)

To interpret the significance of a match between genetically typed samples, you must
know the population distribution of alleles at each locus in question. If the genotype of
the relevant evidence sample is different from the genotype of a suspects reference
sample, then the suspect is excluded as the donor of the biological evidence that was
tested. An exclusion is independent of the frequency of the two genotypes in the
population.

If the suspect and evidence samples have the same genotype, then the suspect is
included as a possible source of the evidence sample. The probability that another,
unrelated individual would also match the evidence sample is estimated by the
frequency of that genotype in the relevant population(s).

The Identifiler Kit, prior to the addition of the D8S1179 degenerate primer, was
used to generate the population data provided in this section. Samples were collected
from individuals throughout the United States with no geographical preference.

Number
Population of Samples provided by
samples
African-American 357 Kentucky State Police and the Federal Bureau of
U.S. Caucasian 349 | Investigation
U.S. Hispanic 290 Minnesota Bureau of Criminal Apprehension/Memorial
. - Blood Center of Minneapolis
Native American 191

In addition to the alleles that were observed and recorded in the Life Technologies
databases, other alleles have been published or reported to Life Technologies by other
laboratories (see the STRBase at www.cstl.nist.gov/div831/strbase).

Table 5 shows the Identifiler'" Direct Kit allele frequencies in four populations, listed
as percentages.

Table5 Identifiler™ Direct Kit allele frequencies

Afric_an- U.S._ U.S. Hispanic Nati_ve
Allele American Caucasian (n = 290) American
(n = 357) (n = 349) (n=191)
CSF1PO

6 t + t t

7 4.62 0.147 0.347 T

8 7.56 0.29% 017t 0.52F

9 3.78 1.72 0.86% 8.38

10 27.87 ' 24.21 23.10 30.89

" 20.59 31.91 28.28 21.99
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Afric§n- U.S._ U.S. Hispanic Nati_ve
Allele American Caucasian (n = 290) American

(n = 357) (n = 349) (n=191)
113 0.14% t t t
12 29.13 ' 32.81 39.66 32.72
13 5.32 7.31 6.38 4.71
14 0.98 143 0.86* 0.79t
15 T 0.29* t t

D251338 '
15 0.14% t t t
16 5.32 4.73 2.41 2.62
17 10.78 17.34 21.21 9.95
18 5.60 ' 6.30 414 7.07
19 14.15 13.75 22.76 29.58
20 6.02 14.61 13.79 9.69
21 14.01 2.58 2.59 2.38
22 13.17 ' 4.01 7.41 15.18
23 10.78 11.46 11.36 11.78
24 9.80 11.75 8.45 7.85
25 8.12 10.60 5.17 3.14
26 1.96 ' 2.72 0.69" 0.79*
27 0.14% 0.14t t t
28 t t T T
D351358

<11 0.42t ' 0.14t t t
1 t t t 0.26
12 0.56* t 0.17 t
13 0.70t 0.29* 017 t
14 12.04 ' 15.76 7.41 6.81
15 30.53 25.36 39.14 40.84
15.2 0.14% t t t
16 28.57 22.78 26.72 32.98
17 19.47 ' 18.19 16.03 9.95
18 6.72 16.48 8.97 8.38
19 0.84 1.00 1.03 0.79t
20 T t 034t t
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Afric§n- U.S._ U.S. Hispanic Nati_ve
Allele American Caucasian (n = 290) American
(n = 357) (n = 349) (n=191)
D55818
7 0.14" ' t 6.72 15.71
8 5.46 t 0.69* t
9 1.68 4.15 5.17 6.02
10 6.72 5.44 5.17 419
11 25.49 ' 39.26 39.14 41.10
12 36.41 35.24 29.31 23.30
13 21.57 15.47 12.59 9.42
14 2.38 0.14t 0.69* 0.26"
15 T ' 0.29% 0.18" T
16 t t 0.17 t
17 0.14% t 0.17 t
D75820
6 T ' 0.14" 0.17t T
7 0.42t 1.29 1.72 0.52
8 18.77 16.48 11.72 13.09
9 13.73 17.62 6.21 8.12
10 34.45 ' 27.22 27.41 21.99
1 19.89 18.05 28.79 28.80
12 10.78 14.76 20.17 24.08
13 1.54 3.72 3.45 3.40
14 0.42t ' 0.72 0.34" T
15 T T T T
D8S1179
8 0.42t 2.29 0.34t 0.52
9 0.42t ' 1.15 0.34t 0.26
10 2.38 9.74 8.45 4.71
1 3.92 6.02 5.86 3.40
12 13.31 14.04 12.07 11.52
13 23.25 ' 32.52 32.93 37.43
14 30.11 21.35 26.21 30.63
15 20.17 9.89 10.86 9.42
16 4.62 2.72 2.41 1,57
17 1.12 ' 0.29% 0.52f 0.52f
18 0.28t t t t
19 t t T T
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Afric§n- U.S._ U.S. Hispanic Nati_ve
Allele American Caucasian (n = 290) American
(n = 357) (n = 349) (n=191)
D13S317
8 3.08 12.18 9.66 4.97
9 2.52 7.74 21.72 17.80
10 3.78 444 9.14 13.61
1" 24.51 29.80 23.10 24.35
12 46.22 30.80 20.86 23.04
13 15.41 11.17 10.17 7.85
14 4.34 3.72 5.34 8.12
15 0.147 0.14% T 0.26%
D16S539
5 t t t t
8 3.22 1.72 1.72 0.79%
9 19.05 10.46 9.31 12.30
10 10.92 5.59 15.69 15.45
1" 31.51 31.95 30.17 30.89
12 18.77 30.23 29.48 27.75
13 14.85 16.76 11.55 10.73
14 1.54 3.01 2.07 2.09
15 0.147 0.291 T T
D18S51
7 t t t t
9 0.147 T T T
10 0.287 0.86 0.527 0.797
10.2 0.14% U T T
1" 0.28" 1.15 1.21 T
12 7.00 13.90 10.34 14.92
13 4.34 12.18 14.48 9.16
13.2 0.42% U T T
14 6.86 16.76 15.52 26.96
14.2 0.287 T T T
15 19.47 13.61 16.55 12.04
16 16.53 13.61 11.72 10.73
17 18.21 12.32 14.14 14.66
18 11.90 7.74 6.72 2.62
19 6.02 444 414 3.93
20 4.90 1.72 2.24 1.83
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Afric§n- U.S._ U.S. Hispanic Nati_ve
Allele American Caucasian (n = 290) American
(n = 357) (n = 349) (n=191)
21 2.10 1.00 1.03 1.31
22 0.70f 0.43% 0.527 0.797
23 0.427 0.14% 0.527 0.267
24 T 0.147 017t T
25 t T 0.17% T
2 t + t t
27 t t t t
D19S433
9 t 0.14% 0.17% T
10 1.54 T T T
" 7.14 0.72 0.527 0.527
11.2 0.14% U 017t T
12 10.78 7.74 6.21 3.14
12.2 6.30 0.577 1.90 T
13 29.83 28.94 16.03 17.80
14 21.01 34.10 31.72 24.87
14.2 4.20 0.86 5.00 3.66
15 4.76 15.76 13.45 13.35
15.2 3.36 2.72 8.79 10.73
16 2.38 4.15 4.31 3.93
16.2 2.38 1.72 2.93 1.83
17 f 0.291 0.17% 0.79%
17.2 0.287 0.291 T 2.88
18.2 0.14% 0.297 T 1.057
D21S11
24 t + t t
24.2 0.147 0.43f 0177 T
24.3 T U T T
25 T T T T
25.2 f 0.14% 0177 T
26 0.147 0.14% 0177 T
27 5.04 4.58 1.21 0.52F
28 22.97 16.76 9.14 6.28
28.2 t + t t
29 19.33 20.49 21.21 16.75
29.2 0.14% U 0.52F 0.26%

90
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Afric§n- U.S._ U.S. Hispanic Nati_ve
Allele American Caucasian (n = 290) American
(n = 357) (n = 349) (n=191)
29.3 0.14F T t T
30 17.23 25.21 29.31 34.29
30.2 1.40 3.30 2.93 1.83
31 7.98 7.16 6.72 5.76
31.2 7.98 9.46 8.62 18.85
32 1.12 1.43 1.55 0.797
32.2 5.88 7.16 12.93 9.69
33 0.561 U T 0.52F
33.2 3.78 3.30 414 3.66
34 1.26 T T T
34.1 0.147 T T T
34.2 0.14% 0.297 0.86% 0.79%
35 2.94 T 0.347 T
35.1 0.147 T T T
35.2 T 0.14% T T
36 0.84 U T T
37 0.28" T t T
38 0.147 T T T
FGA
16 T 0.147 T T
16.1 0.14F T t T
17 f 0.291 0.17% T
17.2 0.147 T T T
18 0.70% 2.72 0.52F 1.31
18.2 1.40 T T T
19 6.72 6.16 7.07 10.21
19.2 0.287 T T T
20 7.00 13.90 7.41 12.30
20.2 t 0.14% T T
21 12.89 16.91 14.66 12.83
22 21.57 16.91 17.24 10.47
22.2 0.28% 1.29 0.34% 0.26%
22.3 0.147 0.14% T T
23 14.99 15.19 11.90 15.97
23.2 0.147 0.14% 0.867 0.267
24 17.51 13.75 15.34 15.71
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Afric§n- U.S._ U.S. Hispanic Nati_ve
Allele American Caucasian (n = 290) American
(n = 357) (n = 349) (n=191)
24.2 t 0.14% 0.17t t
25 7.98 ' 8.60 1414 14.14
26 3.50 2.72 6.90 4.45
26.2 T U T 0.52
29 0.56T T T T
30 t t t t
30.2 0.147 T T T
31.2 T T T T
32.2 T T T T
33.2 t ' + t t
34.2 0.147 T T T
42.2 T T T T
43.2 T T T T
44.2 0.28 ' t t t
45.2 T T T 0.267
46.2 0.14% U T T
47.2 t t T T
482 0147 t t t
50.2 T T T T
51.2 T U T T
THO1
4 t t t t
5 0.287 0.43f 0177 T
6 11.06 20.49 22.76 20.68
7 42.86 21.78 33.62 43.98
8 20.73 ' 11.46 8.45 5.24
8.3 T T T T
9 T U T 6.28
9.3 11.62 29.08 20.34 23.56
10 0.98 ' 0.43% 0.52F 0.26%
T t + + t
13.3 0.14% U T T
TPOX
6 6.72 ' 0.141 0.34 t
7 2.24 T 0.347 0.267
8 36.13 53.30 49.66 37.96

92 AmpFISTR™ Identifiler™ Direct PCR Amplification Kit User Guide



Chapter 5 Experiments and Results
Population data

Afric?n- U.S._ U.S. Hispanic Nati_ve
Allele American Caucasian (n = 290) American

(n = 357) (n = 349) (n=191)
9 21.15 11.60 7.24 4.19
10 9.24 4.30 4.66 3.40
1 21.43 25.93 27.24 39.27
12 3.08 4.73 10.52 14.92
13 T T T T

VWA

" 0.287 T 0177 T
12 T U T 0.26%
13 1.26 0.437 T 0.26%
14 7.14 8.31 6.90 4.45
15 20.03 11.32 10.00 7.07
16 26.75 23.35 34.31 32.98
17 20.59 24.50 21.55 33.51
18 14.71 22.49 18.45 15.45
19 6.72 8.31 7.07 4.71
20 1.96 1.15 1.38 1.057
21 0.28" T 0.17% 0.26"
22 0.287 T T T
23 T T T T
24 T 0.14% T T

t A minimum allele frequency (0.7% for the African-American database, 0.7% for the U.S. Caucasian database,
0.9% for the U.S. Hispanic database, and 1.3% for the Native American database] is suggested by the
National Research Council in forensic calculations.

Low-frequency alleles

Some alleles of the Identifiler"" Direct Kit loci occur at a low frequency. For these
alleles, a minimum frequency (5 divided by 2n, where n equals the number of

individuals in the database) was assigned for the Identifiler'" Direct Kit African-

American, Asian, U.S. Caucasian, and U.S. Hispanic databases, as suggested in the
1996 report of the Committee on DNA Forensic Science (National Research Council,

1996). These databases are summarized in Table 5 on page 86. The minimum

reportable genotype frequency at each locus is: 1.19 X 1074 for the African-American
database; 1.19 X 104 for the U.S. Caucasian database; 1.70 X 10~ for the U.S. Hispanic
database; and 2.97 X 10~# for the Native American database [p2 + p(1-p) 6, where 6 =

0.01]. Hence, the minimum combined multilocus genotype frequency at 15 loci is:
1.36 X 10-9 for the African-American database; 1.36 X 10~ for the U.S. Caucasian
database; 2.86 X 10~ for the U.S. Hispanic database; and 1.23 x 1053 for the Native

American database.
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Population data

Evaluation of
Hardy-Weinberg
equilibrium

94

Estimates of expected heterozygosity (HExp) were computed as described by Nei, M.
(1973) using the program PopGene 1.32. Possible divergence from Hardy-Weinberg
expectations (HWE) was tested using various methods: by calculating the unbiased
estimate of the expected homozygote/heterozygote frequencies (Levene, H., Nei, M.
1978) and using chi-square (HW X2p) and likelihood ratio (HW GZ2p) tests (as
implemented in the program PopGene 1.32): and with an exact test (HW Exact p),
which is a Markov chain method, based on 1000 shuffling experiments, to estimate
without bias the exact P-value of the Hardy-Weinberg test with multiple alleles (Guo,
S.W. 1992), as implemented in the program GenePop 3.4. An inter-class correlation test
analysis (Burrows' composite measure of linkage disequilibria between pairs of loci
and X2 tests for significance [Weir, B. 1990]) was performed separately in each
population to detect any correlations between alleles at any of the pair-wise
comparisons of the 15 loci, using the program PopGene 1.32.

Observed heterozygosity (H,), expected heterozygosity, information content, and tests
for detecting departures from Hardy-Weinberg equilibrium are shown for each
population in Table 6. While a number of the chi-square tests gave seemingly
significant p-values (putatively indicating departures from Hardy-Weinberg
equilibrium), chi-squared tests are very sensitive to small expected values (as in the
case of multiple rare alleles where the expected number of certain genotypes is 1 or
fewer, such as with some of these markers), and can greatly inflate the test statistic in
this situation (Weir, B. 1990). With the exact test, the number of tests with p-value
<0.05 were 0 in the African American and U.S. Caucasian populations, 1 in the U.S.
Hispanic population (D851179; p=0.0304) and 2 in the Native Americans (D21511,
p=0.0118; D55818, p=0.0205). These are no more than would be expected by chance. No
more alleles were observed to be in linkage disequilibrium than would be expected by
chance alone. The average observed heterozygosity across the 15 STR loci was 0.804 in
the African American population, 0.792 in the U.S. Caucasian sample population, 0.793
in the Hispanic sample population, and 0.757 in the Native Americans. The most
heterozygous locus was FGA (mean observed heterozygosity across all populations of
0.875), and the least heterozygous STR locus was TPOX (mean observed
heterozygosity across all populations of 0.677).

Table 6 Heterozygosity and p-values for Hardy-Weinberg tests of the 15 Identifiler STR loci in
four U.S. populations®

African- u.s. . - Native
- . U.S. Hispanic -
American Caucasian (n = 290) American
(n = 357) (n = 349) - (n=191)
CSF1P0
HW X2 p 0.13649 0.926431 0.951476 0.839278
HW G2 p 0.08902 0.894972 0.918038 0.728023
HW Exact p 0.0762 0.2688 0.5456 0.6148
HExp 0.7829 0.7267 0.7051 0.7398
H, 0.7703 | 0.7421 0.7138 0.7958

+ HW X2 p, probability value of X2 test for Hardy-Weinberg equilibrium; HW G2 p, probability
value of the G-statistic of the Likelihood Ratio test for multinomial proportions; HW Exact
p; A Markov chain unbiased exact test to estimate the P-value of the Hardy-Weinberg test
with multiple alleles; Hexp, Expected heterozygosity; H,, observed heterozygosity
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Population data

African- U.S. . . Native

American Caucasian U[Sn I:Il;gg;\lc American

(n = 357) (n = 349) - (n=191)
D251338
HW X2 p 0.409878 0.537758 0.975972 0.722543
HW G2 p 0.962501 0.407932 0.973054 0.760953
HW Exact p 0.7838 0.3488 0.9794 0.5825
HExp 0.8936 0.8823 0.8529 0.8428
H, 0.8768 | 0.8653 0.8379 0.801
D351358
HW X2 p 0.947371 0.670787 0.681659 0.087223
HW G2 p 0.907905 0.654776 0.852278 0.175807
HW Exact p 0.2967 ' 0.2814 0.4684 0.0614
HExp 0.7681 0.7986 0.7361 0.7028
H, 0.7955 0.8166 0.7414 0.7382
D55818
HW X2 p 0.993751 0.859805 0.944725 0.073002
HW G2 p 0.989776 0.520417 0.979044 0.08025
HW Exact p 0.958 0.462 0.4662 0.0205
HExp 0.7476 0.6931 0.7351 0.7378
H, 0.7479 ' 0.7077 0.7586 0.6806
D7S820
HW X2 p 0.987668 0.571989 0.336834 0.324754
HW G2 p 0.969887 0.44694 0.687948 0.289733
HW Exact p 0.9818 | 0.2286 0.4028 0.1276
HExp 0.7758 0.8117 0.7822 0.7858
H, 0.7955 0.7908 0.7862 0.7487
D8S1179
HW X2 p 0.067164 0.545414 0.047783 0.446248
HW G2 p 0.568837 0.275218 0.302937 0.760077
HW Exact p 0.2176 0.3264 0.0304 0.1656
HExp 0.7925 0.8047 0.7853 0.7403
H, 0.7899 | 0.8424 0.8 0.6806
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Population data

African- U.S. . . Native

American Caucasian U[Sn I:Il;gg;\lc American

(n = 357) (n = 349) - (n=191)
D13S317
HW X2 p 0.014379 0.711127 0.353995 0.813948
HW G2 p 0.609389 0.871173 0.190736 0.814681
HW Exact p 0.3818 0.667 0.2415 0.6851
HExp 0.6977 0.7797 0.8251 0.8222
H, 0.6695 ' 0.7364 0.8207 0.8168
D16S539
HW X2 p 0.433216 0.67702 0.058631 0.996396
HW G2 p 0.482435 0.594871 0.37601 0.981384
HW Exact p 0.3753 | 0.4328 0.3068 0.9986
HExp 0.7939 0.7632 0.7747 0.7766
H, 0.8263 0.7822 0.7828 0.7853
D18S51
HW X2 p 0.999844 0.628334 0.999203 0.343027
HW G2 p 1 0.872113 0.999492 0.798859
HW Exact p 0.978 0.0982 0.9152 0.2265
HExp 0.8694 0.8769 0.8761 0.8463
H, 0.8824 | 0.8682 0.8862 0.8377
D19S433
HW X2 p 0.91703 0.806717 0.731222 0.810711
HW G2 p 0.83419 0.999765 0.975476 0.898389
HW Exact p 0.4517 L 0.69 0.3475 0.4301
HExp 0.8364 0.7659 0.8310 0.8430
H, 0.8011 0.7622 0.8414 0.822
D21S11
HW X2 p 0.985687 0.936146 0 0
HW G2 p 1 0.999757 0.999794 0.712937
HW Exact p 0.7627 0.7861 0.6476 0.0118
HExp 0.8585 0.8427 0.8290 0.8003
H, 0.8711 | 0.8567 0.7931 0.801
FGA
HW X2 p 0 0.904953 0.263223 0.999686
HW G2 p 1 0.999812 0.960137 0.999946
HW Exact p 0.9761 | 0.4459 0.0891 0.9161
HExp 0.8659 0.8686 0.8751 0.8746
H, 0.8824 0.8854 0.8724 0.8482

96 AmpFISTR™ Identifiler™ Direct PCR Amplification Kit User Guide



Concordance
studies

Mutation rate

Chapter 5 Experiments and Results

Mutation rate

African- u.s. . - Native
American Caucasian U[Sn I:Il;gg;\lc American
(n = 357) (n = 349) h (n=191)
THO1
HW X2 p 0.961911 0.997905 0.649467 0.329461
HW G2 p 0.940414 0.99169 0.617212 0.318591
HW Exact p 0.8286 0.9716 0.4495 0.1377
HExp 0.7323 0.7866 0.7666 0.7016
Ho 0.7395 ' 0.7822 0.8103 0.6492
TPOX
HW X2 p 0.765163 0.801518 0.875348 0.333914
HW G2 p 0.611014 0.757735 0.913091 0.229017
HW Exact p 0.7247 | 05775 0.8356 0.0647
HExp 0.7643 0.6311 0.6607 0.6765
Ho 0.7563 0.6304 0.6759 0.6178
VWA
HW X2 p 0.925176 0.005048 0.641684 0.994248
HW G2 p 0.964308 0.218817 0.934427 0.997184
HW Exact p 0.7033 0.0564 0.7066 0.8845
HExp 0.8141 0.8081 0.7818 0.7457
Ho 0.8571 08138 0.7759 0.7277

We compared allele calls between the Identifiler'" and Identifiler" Direct Kits.

The genotype data from the 200 analyzed treated paper workflow samples showed
100% concordance between the Identifiler" and Identifiler" Direct Kits.

The genotype data from 84 buccal samples processed using Prep-n-Go'" Buffer and the
Identifiler" Direct Kit showed 100% concordance to allele calls generated for purified
DNA samples analyzed with the Identifiler ™ kit.

Estimation of spontaneous or induced germline mutation at genetic loci can be
achieved by comparing the genotypes of offspring to those of their parents. From such
comparisons the number of observed mutations are counted directly.

In previous studies, genotypes of ten STR loci that were amplified by the
AmpF(STR™ SGM Plus™ PCR Amplification Kit were determined for a total of

146 parent-offspring allelic transfers (meioses) at the Forensic Science Service,
Birmingham, England. One length-based STR mutation was observed at the D18511
locus; mutations were not detected at any of the other nine STR loci. The D18511
mutation was represented by an increase of one 4-nt repeat unit, allele 17 was inherited
as allele 18 (single-step mutation). The maternal/paternal source of this mutation could
not be distinguished.
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Probability of identity

Additional Additional studies (Edwards et al., 1991; Edwards et al., 1992; Weber and Wong, 1993;

mutation studies Hammond et al., 1994; Brinkmann ef al., 1995; Chakraborty et al., 1996, Chakraborty et
al., 1997; Brinkmann et al., 1998; Momhinweg et al., 1998; Szibor ef al., 1998) of direct
mutation rate counts produced:

» Larger sample sizes for some of the Identifiler™" Direct Kit loci.

e Methods for modifications of these mutation rates (to infer mutation rates
indirectly for those loci where the rates are not large enough to be measured
directly and/or to account for those events undetectable as Mendelian errors).

Probability of identity

Table 7 shows the Probability of Identity (Pj) values of the Identifiler " Direct Kit
loci individually and combined.

Table7 Probability of Identity values for the Identifiler™ Direct Kit STR loci

Locus Afric_an- U'S'. U.S. Hispanic Nati_ve
American Caucasian American
CSF1PO 0.079 0.132 0.141 0.123
D251338 0.023 0.027 0.038 0.043
D351358 0.097 0.076 0.112 0.158
D55818 0.104 0.147 0.115 0.110
D75820 0.085 0.063 0.083 0.081
D8S1179 0.074 0.064 0.089 0.104
D13S317 0.132 0.079 0.056 0.056
D165539 0.077 0.097 0.090 0.082
D18S51 0.033 0.031 0.031 0.046
D19S433 0.042 0.087 0.049 0.044
D21S11 0.037 0.044 0.047 0.074
FGA 0.034 0.035 0.032 0.031
THO1 0.109 0.079 0.097 0.134
TPOX 0.089 0.188 0.168 0.159
VWA 0.066 0.066 0.080 0.103
Combined 1.31 X 1018 5.01 X 1018 7.65 X 1018 3.62 X 10717

The P; value is the probability that two individuals selected at random will have an
identical Identifiler™ Direct Kit genotype (Sensabaugh, 1982). The P; values for the
populations described in this section are then approximately 1/7.64 X 1017 (African-
American), 1/2.00 X 1017 (U.S. Caucasian), 1/1.31 X 1017 (U.S. Hispanic), and 1/2.76 X
1016 (Native American).

98 AmpFISTR™ Identifiler™ Direct PCR Amplification Kit User Guide



Probability of paternity exclusion

Chapter 5 Experiments and Results
Probability of paternity exclusion

Table 8 shows the Probability of Paternity Exclusion (Pg) values of the Identifiler™
Direct Kit STR loci individually and combined.

Table8 Probability of Paternity Exclusion values for the Identifiler™ Direct Kit loci

Locus Afric_an- U'S'. U.S. Hispanic Nati_ve
American Caucasian American
CSF1PO 0.545 0.496 0.450 0.409
D251338 0.748 0.725 0.671 0.399
D351358 0.591 0.630 0.495 0.510
D55818 0.506 0.440 0.525 0.601
D75820 0.591 0.582 0.574 0.492
D8S1179 0.580 0.680 0.599 0.601
D13S317 0.383 0.487 0.638 0.370
D165539 0.649 0.566 0.567 0.428
D18S51 0.760 0.731 0.767 0.329
D19S433 0.601 0.531 0.678 0.360
D21S11 0.737 0.708 0.586 0.399
FGA 0.760 0.766 0.739 0.309
THO1 0.492 0.566 0.618 0.646
TPOX 0.521 0.329 0.392 0.687
VWA 0.709 0.625 0.555 0.528
Combined 0.9999996 0.9999992 0.9999990 0.9999527

The Pg value is the probability, averaged over all possible mother-child pairs, that a

random alleged father will be excluded from paternity after DNA typing of the
Identifiler' Direct Kit STR loci (Chakraborty and Stivers, 1996).
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that occur

during analysis.

Table 9 Troubleshooting

Observation

Possible causes

Recommended actions

Faint or no signal from
both the AmpF(STR™
Identifiler™ Direct
Control DNA 9947A and
the DNA test samples at
all loci

Incorrect volume or absence of
Identifiler™ Direct Master Mix or
Identifiler™ Direct Primer Set

Repeat amplification.

No activation of AmpliTag Gold™ DNA

Polymerase

Repeat amplification, making sure to hold
reactions initially at 95°C for 11 minutes.

Master Mix not vortexed thoroughly

before aliquoting

Vortex the Master Mix thoroughly.

Identifiler™ Direct Primer Set
exposed to too much light

Store the Primer Set protected from light.

PCR System malfunction

Refer to the thermal cycler user’s manual and
check instrument calibration.

Use of incorrect thermal cycling
parameters

Check the protocol for correct thermal cycling
parameters.

MicroAmp™ Base used with tray/
retainer set and tubes in
GeneAmp™ 9700

Remove MicroAmp Base from tray/retainer set
and repeat test.

Insufficient PCR product
electrokinetically injected

Prepare PCR product as described in Chapter 3,
“Perform Electrophoresis” on page 27.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di™ Formamide.

Sample punch location was not
optimal

For blood samples on treated paper, punch in the
center of the blood stain.

For buccal samples on treated paper, punch in the
center of the buccal transfer or punch in the
optimal spot based on past experiences.

For buccal samples collected with the Bode
Buccal DNA Collector™, punch from near the tip of
the collector.

Insufficient lysis of the swab head

Ensure swab heads are incubated for 20 minutes
in 400 uL Prep-N-Go™ Buffer.
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Appendix A Troubleshooting

Observation

Possible causes

Recommended actions

More than two alleles
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Amplification of stutter product
(n-4 nt position)

See “Stutter products” on page 73.

Incomplete 3° A base addition (n-1 nt
position)

See “Addition of 3" A nucleotide” on page 78. Be
sure to include the final extension step of 60°C for
10 minutes in the PCR.

Signal exceeds dynamic range of
instrument (off-scale data)

Ensure cycle number is optimized according to
instructions on page 17. Repeat PCR amplification
using fewer PCR cycles or use your laboratory’s
SOP to analyze off-scale data.

Poor spectral separation (bad matrix)

Follow the steps for creating a spectral file.

Confirm that Filter Set G5 modules are installed
and used for analysis.

Contamination carried over from the
disc punching tool

Clean the disc punching tool thoroughly. If
necessary, include a blank punch step in between
the sample punches.

Incomplete denaturation of double
stranded DNA

Use recommended amount of Hi-Di"™ Formamide
and perform heat denaturation step according to
the instructions in Chapter 3, “Perform
Electrophoresis”.

Some but not all loci
visible on
electropherogram of
DNA Test Samples

Disc size used in the amplification
reaction was greater than 1.2 mm

Repeat amplification using a use 1.2 mm punch
size.

Insufficient volume of swab lysate
added to the reaction

Repeat amplification using the recommended
lysate input volume.

Less than 25 pL of PCR reaction
volume was used

Repeat amplification using the recommended PCR
reaction volume of 25 pL.

STR profiles contain
many off-scale alleles

PCR cycle number was too high

Perform sensitivity experiment (page 17) to
determine the optimal PCR cycle number based
on the sample type.

For blood samples: Too much liquid
blood was spotted onto paper
substrate

Spot <100 pL of liquid blood per sample area.
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Ordering Information

Equipment and materials not included

Table 10 and Table 11 list required and optional equipment and materials not supplied

with the Identifiler Direct Kit. Unless otherwise noted, many of the items are
available from major laboratory suppliers (MLS).

Table 10 Equipment

Equipment Source
3100/3100-Avant Genetic Analyzer Contact your local Life
Applied Biosystems™ 3500/3500xL Genetic Analyzer Ig;r:soelg?;:iesales
Applied Biosystems™ 3130/3130x( Genetic Analyzer
Applied Biosystems™ 3730 Genetic Analyzer
GeneAmp™ PCR System 9700 with the Silver 96-Well Block . N8050001
GeneAmp™ PCR System 9700 with the Gold-plated Silver 96-Well Block 4314878
Silver 96-Well Sample Block N8050251
Gold-plated Silver 96-Well Sample Block 4314443
Veriti™ 96-Well Thermal Cycler . 4375786
ProFlex™ 96-Well PCR System 4484075
Tabletop centrifuge with 96-Well Plate Adapters (optional) MLS
Harris Manual Punch, 1.2 mm MLS
CPA200 Semi-Automated Punch Instrument with a 1.2 mm punch head " Contact your local Life

Technologies support
representative for
information.

CPA300 Fully-Automated Punch Instrument with a 1.2 mm punch head

Bode Buccal DNA Collector™ 4467893

This part number is
not available for sale
in the US.

Copan FLOQSwabs™ Contact your local Life
Technologies support
representative for
information.

AmpFLSTR™ Identifiler ™ Direct PCR Amplification Kit User Guide 103



E Appendix B Ordering Information

Equipment and materials not included

Equipment Source

Copan NUCLEIC-CARD™ system Contact your local Life
Technologies support
representative for
information.

This product is not
available for sale in

the US.
96-well, deep-well plate 4392904
Table 11 User-supplied materials

Item? Source
AmpF(STR™ Identifiler™ Direct PCR Amplification Kit, 200 reaction 4467831
AmpF(STR™ Identifiler™ Direct PCR Amplification Kit, 1000 reaction . 4408580
Prep-n-Go™ Buffer (untreated paper substrate) 4467079
Prep-n-Go™ Buffer (buccal swab) 4471406
3100 Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x! Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4™ Polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well ' 4316471
GeneScan™ 500 LIZ™ Size Standard 4322682
OR OR
GeneScan™ 600 LIZ™ Size Standard v2.0 4408399
Running Buffer, 10X ' 402824
Hi-Di™ Formamide 4311320
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp™ Optical 96-Well Reaction Plate N8010560
250-pL Glass Syringe (array-fill syringe) . 4304470
5.0-mL Glass Syringe (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100 instrument, refer to Appendix B of the 37100 Genetic Analyzer and
3100-Avant Genetic Analyzer User Reference Guide (Part no. 4335393).

3130x! Analyzer materials

96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x! Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4™ Polymer for 3130/3130x( Genetic Analyzers 4352755
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well ' 4316471
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Item? Source
GeneScan™ 500 LIZ™ Size Standard 4322682
OR OR
GeneScan™ 600 LIZ™ Size Standard v2.0 4408399
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Hi-Di™ Formamide 4311320

For a complete list of parts and accessories for the 3130x( instrument, refer to Appendix A of the Applied Biosystems 3130/
3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Part no. 4352716).

3500/3500xL Analyzer materials

Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4™ polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4™ polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
GeneScan™ 600 LIZ™ Size Standard v2.0 4408399
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715

For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems ™

3500/3500xL Genetic Analyzer User Guide (PN 4401661).

3730 Analyzer materials

3730 DNA Analyzer Capillary Array, 36-cm 4331247
GeneScan™ 500 LIZ™ Size Standard 4322682
OR OR
GeneScan™ 600 LIZ™ Size Standard v2.0 4408399
Hi-Di™ Formamide 4311320
Running Buffer, 10X 4335613
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
96-Well Plate Septa 4315933
MicroAmp™ Optical 96-Well Reaction Plate N8010560
POP-7" Polymer for the 3730 Genetic Analyzer 4332241
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Equipment and materials not included

Itemt Source

For a complete list of parts and accessories for the 3730 instrument, refer to Appendix A of the Applied Biosystems ™
3730/ 3730xt DNA Analyzer Getting Started Guide (Part no. 4359476).

PCR Amplification

MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2-mL N8010540
MicroAmp™ 8-Tube Strip, 0.2-mL N8010580
MicroAmp™ 8-Cap Strip . N8010535
MicroAmp™ 96-Well Tray/Retainer Set 403081
MicroAmp™ 96-Well Base N8010531
MicroAmp™ Clear Adhesive Film 4306311
MicroAmp™ Optical Adhesive Film . 4311971
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips . MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS

t For the Safety Data Sheet (SDS) of any chemical not distributed by Life Technologies, contact the chemical manufacturer. Before handling any
chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
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Plate Layouts

Example PCR plate layout

The following layout is recommended for use with the sensitivity experiment on
page 17. Create 3 identical plates for amplification at 3 different cycle numbers.

1 2 3 4 ] B 7 g o 10 1 12

Samp 1 | Samp 8 [Samp 15 | Samp 22

Samp 2 | Samp 9 |Samp 16 |Samp 23

Samp 3 | Samp 10| Samp 17 |Samp 24

Samp 4 | Samp 11 |Samp 18 | Samp 25

Samp S |[Samp12|Samp19 | Samp 26

Samp & | Samp13|Samp 20 | Neg cirl

Samp 7 | Sampld|(Samp 21 | 9947 A

T|@|m|(m{Oofo|@]|F

Example electrophoresis plate layout

The following layout is recommended for use with the sensitivity experiment on
page 17.

1 2 3 4 3 ] 7 g g 10 1 12

Samp 1 | Samp 8 | Sampi15|Samp22 | Sampl | Samp & |[Samp1S5 | Samp 22 ['Samp 1o Samp 8 | Samp 15| Samp 22

Samp 2 | Samp 9 | SampiG | Samp23 | Samp2 | Samp 9 |Samp1B | Samp 23 |[Samp 2 Samp 9 | Samp 16 Samp 23

Samp 3 |Samp 10 | Sampi7 [Samp24 | Samp 3 | Samp 10 |Samp 17 |Samp 24 |['Samp 3 Samp 10| Samp 17 Samp24

Samp 4 | Samp 11 [ Sampi18 | Samp 25 | Sampd | Samp 1l [ Samp 18 | Samp 25 [ Sampd i pSamp 11 Samp 18 Samp 25

Samp 5 |Samp 12 | Samp19|Samp 26 | Samps |[Samp 12 |Samp 19 | Samp 26 | Samp 5 pSamp 12 | Samp 13 5amp 26

Samp 6 | Samp 13 [ Samp 20| Megclrl | Samp B | Samp 13 [ Samp 20 | Megchrl [ Samp Bl Samp 13 Samp 20 Neg ol

Samp 7 | Samp 14 [ Samp 21| 9924748 | Samp 7 | Samp 14 [ Samp 21 | 90478 Samp Tl Sampidi i Samp 21 | 004 TR

T|(@|m|m|o|lo|m|kE

Alelic CE Allelic CE Allelic CE Allelic CE Allelic CE Allelic CE
Lacder Blank Ladder Blank Ladder Blank L adder Blank Ladder Blank Ladter Blank

Cwicle Cvele 7 Cvwicle 3
Cycle 1 Cycle 2 Cycle 3
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Example electrophoresis plate layout

108 AmpFISTR™ Identifiler™ Direct PCR Amplification Kit User Guide



PCR Work Areas

Work area setup and labdesign............ ... i 109
PCRsetupworkarea......... ... 109
Amplified DNA workarea . ..............uuuuiiiiiiiiinnnn 110

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you
are using the AmpF(STR™ Identifiler " Direct PCR Amplification Kit for:

e Forensic DNA testing, refer to “Forensic Laboratories: Handbook for Facility
Planning, Design, Construction and Moving,” National Institute of Justice, 1998

* Parentage DNA testing, refer to the “Guidance for Standards for Parentage
Relationship Testing Laboratories,” American Association of Blood Banks, 7th
edition, 2004

The sensitivity of the Identifiler’" Direct Kit (and other PCR-based tests) enables
amplification of minute quantities of DNA, necessitating precautions to avoid
contamination of samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by
human DNA. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area

IMPORTANT! These items should never leave the PCR Setup Work Area.

e Calculator

* Gloves, disposable

¢ Marker pen, permanent
¢ Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
¢ Dipettors
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m Appendix D PCR Work Areas
Amplified DNA work area

¢ Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:

e GeneAmp'" PCR System 9700 with the Silver 96-Well Block
e GeneAmp'" PCR System 9700 with the Gold-plated Silver 96-Well Block

IMPORTANT! The Identifiler" Direct Kit is not validated for use with the
GeneAmp' " PCR System 9700 with the Aluminium 96-Well Block. Use of this
thermal cycling platform may adversely affect performance of the
Identifiler Direct Kit.

e Veriti"" 96-Well Thermal Cycler
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Appendix E Safety
Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

* Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

¢ Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.

¢ Handle chemical wastes in a fume hood.

* Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

¢ After emptying a waste container, seal it with the cap provided.

* Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

* Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

¢ IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Specific chemical

. CAS Chemical Phrase
handling

26628-22-8 | Sodium Azide Sodium azide may react with lead and copper
plumbing to form highly explosive metal azides.

Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.
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Appendix E Safety
Biological hazard safety

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:

In the U.S.:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

* Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29c¢fr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

¢ Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:

Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization
(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
csr/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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Documentation and Support

Related documentation

Document title nF:Jar:\tber
3100/3100-Avant Data Collection v2.0 User Guide 4347102
3100/3100-Avant Genetic Analyzers Using Data Collection Software v2.0 User Bulletin 4350218
3100 Genetic Analyzer User Manual (Data Collection v1.1) 4315834
3100/3100-Avant Genetic Analyzers Protocols for Processing AmpFISTR™ PCR Amplification Kit PCR 4332345
Products User Bulletin

Veriti” 96-Well Thermal Cycler AmpFSTR™ Kit Validation User Bulletin 4440754
ProFlex™ PCR System Kit Validation User Bulletin 100031595
Applied Biosystems ™ 3130/3100x! Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
Applied Biosystems ™ 3130/3130xl Genetic Analyzers Getting Started Guide 4352715
Applied Biosystems ™ 3130/3130x( Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
Applied Biosystems ™ 3130/3130x( Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems ™ 3130/3130x( Genetic Analyzers AB Navigator Software Administrator Guide 4359472
Applied Biosystems™ 3130/3100x! DNA Analyzers User Guide 4331468
Applied Biosystems ™ 3500/3500xL Genetic Analyzer Quick Reference Card 4401662
Applied Biosystems™ 3500/3500xL Genetic Analyzer User Guide, Data Collection v1.0 4401661
Applied Biosystems ™ 3500/3500xL. Genetic Analyzer User Bulletin: Solutions to issues related to software, data, 4445098
hardware, and consumables

Note: Additional user bulletins may be available at www.lifetechnologies.com

Applied Biosystems ™ 3730/3730x! Genetic Analyzer Getting Started Guide 4359476
GeneAmp ™ PCR System 9700 Base Module User’s Manual N805-0200
Quantifiler™ Kits: Quantifiler™ Human DNA Quantification Kit and Quantifiler™Y Human Male 4344790
DNA Quantification Kit User’s Manual

AmpFtSTR™ Identifiler™ PCR Amplification Kit User’s Manual 4323291
GeneMapper™ ID Software Version 3.1 Human Identification Analysis User Guide 4338775
GeneMapper™ ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial 4335523
Installation Procedures and New Features for GeneMapper™ ID Software v3.2 User Bulletin 4352543
GeneMapper™ ID-X Software Version 1.0 Getting Started Guide 4375574
GeneMapper™ ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper™ ID-X Software Version 1.0 Reference Guide 4375671
GeneMapper ™ ID-X Software Version 1.1 (Mixture Analysis) Getting Started Guide 4396773
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Documentation and Support
Obtain support

Document title n:ar:\tber

GeneMapper™ ID-X Software Version 1.1 (Mixture Analysis] Quick Reference Guide 4402094
GeneMapper™ ID-X Software Version 1.2 Reference Guide 4426481
GeneMapper™ ID-X Software Version 1.2 Quick Reference Guide 4426482

Portable document format (PDF) versions of this guide and the documents listed above
are available at www.lifetechnologies.com.

Note: To open the user documentation available from the our web site, use the
Adobe™ Acrobat™ Reader™ software available from www.adobe.com.

Obtain support

For HID support:

¢ In North America - Send an email to HIDTechSupport@lifetech.com, or call
888.821.4443 option 1.

* Outside North America — Contact your local support office.
For the latest services and support information for all locations, go to:
www.lifetechnologies.com

At the website, you can:

* Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

* Search through frequently asked questions (FAQs)
¢ Submit a question directly to Technical Support

* Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

¢ Obtain information about customer training

e Download software updates and patches

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the Life Technologies' General Terms and
Conditions of Sale found on Life Technologies' website at www.thermfisher.com/us/en/home/global/terms-and-conditions.html. If you
have any questions, please contact Life Technologies at www.thermofisher.com/support.
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.fsa sample files 36, 49
.hid sample file 48

+A nucleotide addition
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efficiency of 78

Numerics
3100/3100-Avant instruments 29
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A

accuracy and reproducibility 64
alleles
low frequency 93
off-ladder 65
allelic ladder
figure 11
requirements for accurate genotyping 28
volume per reaction 30, 32, 34
analysis method 40, 53
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import 49
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